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Installing Rational System Architect

Introduction

This chapter instructs you how to install IBM® Rational® System Architect® and
related products. The chapter is partitioned into sections that cover different scenatios
of installing the product.

e Installation overview

e Installation scenarios

e System requirements

e Software requirements for Rational System Architect

e Hardware requirements

e Ports and Protocols Used for SQL Server

o Rational System Architect installation scenarios

o L Installations to SQL Server envitonments

e I Installations to SQL Express environments

e III Installations to Oracle environments

e Roaming User Profiles

e Step-by-step instructions to install Rational System Architect
o Installation instructions for upgrading to V11.3

e Upgrading Rational System Architect with upgrades and patches
e Summary of conversion instruction

¢ Silent installation
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Installation overview

IBM provides full Rational System Architect installations only. This means that you need
to uninstall an old Rational System Architect version before you install a new Rational
System Architect version. Periodically, service packs, patches or hot fixes are made
available on the IBM Rational support site
(http://www.ibm.com/software/rational/support/telelogic/) that will update your
existing version. You do not need to uninstall Rational System Architect when you install
a service pack, patch or hot fix, unless otherwise instructed on the support site.

Installation scenarios

Rational System Architect V11 encyclopedias are created on Microsoft® SQL Server
2000, Microsoft SQL Setver 2005®, Microsoft SQL Server 2005 Express® (SQL
Express), and Oracle® 97 Database or Oracle® 10g Database. This creates a number of
installation scenarios — a user may opt to use either SQL Express, SQL Server 2000,
SQL Server 2005, Oracle9: or Oracle 10g as their repository engines. Rational System
Architect’s Startup wizard enables you to install SQL Express onto your machine.

License management

Rational System Architect uses Macrovision FLEXNET™ Licensing system. FLEXnet
licenses are available as node-locked (stand-alone) licenses, which are tied to a specific
machine, and floating (server) licenses, which are available anywhere on the network.

The FLEXnet licensing program must be running at all times Rational System Atchitect
is running. FLEXnet retrieves the number of licenses to provide from the license.dat file.
When FLEXnet runs, it reads the License.dat in a directory on the network or, for stand-
alone machines, in a directory on the local machine. The licenses are distributed to SA
users — Rational System Architect queries License.dat and runs when it finds an available
license slot.

For more information on FLEXnet Licensing see “IBM Rational Lifecycle Solutions
Licensing Guide,” available in the IBM Rational support site
(http://www.ibm.com/software/rational/support/telelogic/) or in the Documentation
DVD of the installation package.
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Enabling localized User Interface

You can enable the Rational System Atrchitect user interface to German, Japanese,
French, or Spanish, as follows:

1.

Open the sa2001.ini file, installed by default to C:\Documents and
Settings\ <UserName>\Local Settings\ Application Data\Telelogic\System
Architect.

Add the following entry at the top of the file:

[SystemArchitect]
Locale=XXX

Values for XXX can be:

409 = English (This is the default.)

407 = German

411 = Japanese (This is set automatically if you use the Japanese installation files.)
40C = French

COA = Spanish

Note: "0" is a zero not the letter "O".

3. Save and close the sa2001.ini file, and restart Rational System Architect.

Upgrading and patches

Upgrading Rational System Atrchitect requites that you uninstall your older

version before installing a new version. Files in the root application folder, in
subfolders, or the folders of related products that you may have customized could be
deleted permanently when you upgrade. Uninstalling a version clears and overwrites the
application folder. Consequently, customizable files such as usrmatrx.xml (for user-
defined matrices), usrprops.txt (copied into newly created encyclopedias), and macro
files (for VBA customizations) could be deleted when you install an upgrade or a patch.

You should also know the following about upgrading Rational System Architect:

Before uninstalling older versions, a good practice is to backup any files that you
customized in the application folder or other folders. After upgrading to the new
version, you can copy yout customized files back to their respective folders and
retain your customizations.

Encyclopedias created with V11.0 or newer are upgraded automatically, with options
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to retain some customizations (for example, those in the USRPROPS. TXT file).

e Encyclopedias created with V10.0 or earlier need to be converted to the version 11.0
format before they can be opened in newer versions. This is done with the Rational
System Architect Encyclopedia Manager tool.

See the ‘Rational System Architect Conversion Guide’ in the Information Center
(http://publib.boulder.ibm.com/infocenter/rsdp/v1rOm0/index.jsp) or in your
installation package.
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System requirements

This section contains Rational System Architect software and hardware requirements.

Note:You must have administrative privileges on the system to install Rational System
Architect (during the installation only).

Software requirements

Rational System Architect uses some of the newest Microsoft® Windows® features,
included in the latest Service Packs and Operating System upgrades that Microsoft
provides (http://www.microsoft.com/downloads). Rational System Architect has been
tested with the following Service Packs, upgrades and software products:

e Windows Vista with SP1 - Installing Rational System Architect V11.3 on this
platforms requires that User Access Control be disabled so the Microsoft .Net
Framework can be installed as required. If the UAC is enabled, the Rational System
Architect installation cannot be completed.

e Windows XP with SP2

e Windows 2000 with SP4

e Windows 2000 Server with SP4

e Windows Server 2003 Standard Edition (R2)

e Windows Server 2003 32-bit Enterprise Edition (R2)
e Windows Server 2003 64-bit Enterprise Edition (R2)

e Microsoft Internet Explorer 6.0® or higher.
Note: This in no way requires you to use IE as your preferred browser.
(http:/ /www.microsoft.com/windows/ie/downloads/default.asp)

e Microsoft Office 2000 or higher (http://officeupdate.microsoft.com)

e Rational System Architect is based in part on software from Colosseum Builders,
Inc.

Additional Products Installed or Used:
Rational System Architect installs or uses the following software:
e Microsoft MSI -- Version 3.0
¢ MDAC -- Version 2.7 (with SP 1)
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Microsoft XML Parser -- Version 3.0 (with SP 7)
Microsoft VBA -- Version 6.3
Microsoft .Net Framework -- Version 2.0

Rational System Architect is based in part on software from Colosseum Builders,
Inc.

International Proofreader™ English (US and UK) text proofing system © 2003 by
Vantage Technology Holdings, Inc. For full copyright information, see the 'Rational
System Architect User Guide,' available in the Information Center
(http://publib.boulder.ibm.com/infocenter/rsdp/v1rOm0/index.jsp) and your
installation package.

Java™ Runtime Environment — to render SVG graphics and other features.

Installation Prerequisite

Rational System Architect and the Rational System Architect DOORS Integration
require that the Microsoft Windows Installer 3.1 Setrvice be installed on the operating
system of the target computer. If it is not present, the installation cannot continue and
you are notified how to obtain and install the Windows Installer 3.1.

Note: If you are installing Rational System Architect V11.3 on Windows Server 2003 64-
bit Enterprise Edition (R2), you must install the following components before installing
Rational System Architect: Microsoft's Net Framework 2.0, SQL Setrver 2005 Backward
Compeatibility 64-bit, and SQL Server 2005 Express 64-bit.

Hardware requirements

The hardware requirements are as follows:

Administrative privileges on the system (during the installation only).

Pentium-class PC, 500 MHz or higher, minimum of 256 MB of RAM, Super VGA
monitor (with the screen resolution set to at least 800 x 600, small fonts setting).

Disk space: 2GB during installation and 300 MB after the install is complete.
Note: Rational System Architect is supported by Citrix Metaframe Presentation

Server 4.0 on Windows 2000 Server, Windows 2003 Server Standard, and Windows
2003 Server Enterprise.
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Ports and Protocols for SQL Server and Oracle

The following ports and protocols have been tested with Rational System Architect:

e SQL Server is a Winsock application that communicates over TCP/IP using the
sockets network library. SQL Server listens for incoming connections on a particular
portt; the default port for SQL Server is 1433. The port does not need to be 1433,
but 1433 is the official Internet Assigned Number Authority IANA) socket number
for SQL Server.

For more information, go to: http://support.microsoft.com/kb/287932/

Note: You can also use the Named Pipes protocol, but the default is TCP/IP.

e Oracle is tested with the TCP protocol, with the standard port 1521. The test
configuration is done with Oracle configuration tools, which generated the

TNSNAMES.ORA file.
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Rational System Architect installation scenarios

This section describes installation types available for Rational System Architect.

Multi-User Installations: Rational System Architect is installed to every client machine.
You can install SQL Express to every client machine. (Users do not need a local instance
of SQL Express if they are always going to use an encyclopedia on the network; it is only
necessary for users who will work on an encyclopedia off-line on their local machine.).
FLEXnet is not installed to client machines — it is installed to a machine always running
on the network. Encyclopedias are created on a SQL Server 2000, SQL Server 2005,
SQL Express, Oracle97 or Oracle 10g servers on the network.

Stand-Alone Installations: To run Rational System Architect from a stand-alone
machine (not connected to the network), you must also have FLEXnet running,
providing you with the necessary Rational System Architect license. When using Rational
System Architect on a stand-alone machine, you work on encyclopedias on a local
instance of SQL Express. Rational System Architect’s Startup Wizard provides you with
the ability to install SQL Express to a machine.

You cannot run Rational System Architect without a valid license. The installation
wizard prompts you for a directory or server where the License.dat file is located. Your
System Administrator should provide the directory or the server where the license is
being administered.

8 Rational System Architect and Rational System Architect XT Installation Guide
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Installing Rational System Architect

Before installing Rational System Architect, you should close other applications that are
running.

During installation of Rational System Architect, you may also optionally install SQL
Server 2005 Express (SQL Express) and Rational System Architect Encyclopedia
Manager (SAEM). These choices are provided in Rational System Architect’s Startup
Wizard.

Note: The installed version of SQL Express is 32 bit. You may download a 64-bit
version of SQL Express from Microsoft.

To install Rational System Architect proceed as follows:

1. Install Rational System Architect as follows:

- If you downloaded the software from the IBM Rational Web Site, double-click on
the executable file you downloaded to run the installation.

- If you received an installation DVD from IBM, insert your Rational System
Architect Installation DVD into your DVD-drive. The auto-run interface is
launched and The IBM Rational Lifecycle Solutions screen appears. Click on the
Install link for IBM Lifecycle Solutions Clients.

2. In the ‘Welcome’ screen, click Next to begin the installation.

3. Follow the instructions provided the Installation Wizard.

Running the Rational System Architect Startup Wizard

The Installation Wizard automates the process of setting up your encyclopedia servers,
installing sample encyclopedias, default frameworks, and other start-up options that
make it easy for you to start using Rational System Architect. If you are evaluating
Rational System Architect, you should use the Startup Wizard to install SQL Express.
This creates a local server on your computer only which you can install and create
encyclopedias.

On computers where Rational System Architect has not been installed before, the first
time that you run Rational System Architect, the Startup Wizard is launched
automatically. You can also run it manually as follows:

1. Launch Rational System Atchitect by selecting Start, Program Files, IBM Rational,
IBM Rational System Architect. You can also click the Rational System Architect
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icon on your Desktop (if you allowed one to be created).
2. Click Help, Startup Wizard.

3. Follow the Startup Wizard screens. If you are evaluating the software, you should
accept the default settings and click Next to navigate through the screens.

4. Configure where encyclopedias will be stored: This screen provides you with the
option to install SQL Server 2005 Express (SQL Express) to your local machine.
You should choose this default setting if you are evaluating the software.

5. Configure Samples Encyclopedia Projects: This screen enables you to select one or
all of the example encyclopedias provided with Rational System Architect to be
attached to your local server (SQL Express installed above). You may also select
which Tutorial you wish to have opened when you first start-up Rational System
Architect.

After you have navigated all of the Startup Wizard’s screens, Rational System Architect
will be ready to use. If you selected a tutorial encyclopedia, it will be opened for you
when start Rational System Architect.
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I. Installations to SQL Server environments

Make sure all Rational System Architect users have proper access rights to SQL Server.
Use SQL Server’s Enterprise Manager tool to provide users with proper access rights to
SQL Server 2000 and SQL Server 2005 on the network.

Access Rights for SQL Server 2000 and SQL Server 2005:

Server Role: For users to be able to create an encyclopedia on a SQL Server 2000
and SQL Server 2005 server, they must have either a Server Role of System
Administrator or Creators. This is granted to the user by the System Administrator
through SQL Server Enterprise Manager (versions 2000 or 2005).

Database Access: For users to be able to open an encyclopedia and read and create
definitions within it, they must have Database Access of db_datareader, and
db_datawriter. The db_ddladmin is required when there is a change in the schema
of a database. For example, when opening up a 10.3 encyclopedia with Rational
System Atrchitect 10.4 or later. Once the encyclopedia is opened (and therefore
converted), the db_ddladmin role is no longer required for a user to read and write
definitions in that encyclopedia.

Execute rights on the following stored procedures:

CREATESNAPSHOT GETHISTORYLOGGINGSTATUS
ENTITYEXISTSBYID LOGENTITYHISTORYUPDATE
LOCKENTITYBYID LOGFILESHISTORYUPDATE

GETNEXTID PURGEHISTORY
GETFILESIZE SAVEAUDITSETTINGS
DELETBYID SAVECHANGECONFIG

If you have not installed SQL Server 2000 SP4, you also need Execute on the
extended stored procedure XP_UserLock. For more information on XP_UserLock,
please see Microsoft’s support Web Site:
http://support.microsoft.com/default.aspx?scid=kb%3Ben-us%3B819829. This is
granted to the user by the System Administrator through SQL Server Enterprise
Manager (versions 2000 or 2005).

Minimum Access Rights for SQL Server 2005, including SQL Express

There is a minimum set of rights needed to open a SQL Server 2005 encyclopedia. The
security model for SQL Server 2005 limits access to the metadata stored in system tables.
Rational System Architect's encyclopedia schema checker needs access to this metadata
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in order for it to work properly. The additional permission needed to view this data is
called VIEW DEFINITION. The permission can be granted as follows:

GRANT VIEW DEFINITION TO <principal>
Where principal is one of the following:

e user /role /application role

e user mapped to a Windows login/group/ certificate
e user mapped to an asymmetric key

e user not mapped to a server principal

e SAEM has been updated to include this permission in the SAUser database role,
thus any users added to this role will be able to open SA encyclopedias. (See the
section ‘Assigning ‘sysadmin’ permissions for SQL Server or SQL Express in
Windows Vista’ below for running SAEM in Windows Vista.)

e System Administrator should tell users where the server is and what their
authentication method will be to create new encyclopedias on the server.

Assigning ‘sysadmin’ permissions for SQL Server or SQL Express in Windows Vista
User Access Control is a new security feature in Windows Vista, which imposes a limit
on the access rights assigned to a user through group memberships. For example, if a
user is a member of Administrators, under Windows XP that user is typically
automatically granted ‘sysadmin’ rights in the SQL Express instance. However, in
Windows Vista those rights are not automatically granted. If an administrative privilege
is granted to a user through a group membership, Vista requires some further action to
ensure that this effective access right is granted to the user.

A common symptom of this problem is that you receive a message such as "CREATE
DATABASE permission denied in database 'master." Another symptom is that you
cannot connect to any database, even though you are a member of the Administrators
group on your machine. If you experience the issues above, it means that you do not
have effective ‘sysadmin’ rights on a SQL Express instance running under Vista. You
can fix this problem by explicitly granting the ‘sysadmin’ role to your user account.

To assign the ‘sysadmin’ role to your user name proceed as follows:

1. Right-click the Rational System Atchitect Encyclopedia Manager (SAEM) icon and
select Run as administrator from the context menu.

2. In SAEM, click Server and select Logins.
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3. Ensure that your user name is showing in the list. If it is not, add it using the Create
a new Login icon.

4. Double-click your user name in the list. The Login Properties dialog is displayed.
5. Click the Server Roles tab, and check sysadmin in the Server roles field.
6. Click OK and close the Logins dialog.

Note: As alternatives to the solution above, you can disable the User Access Control
(which may pose a security issue), or you can run SAEM with Run as Administrator
(step 1 above) each time you want to run SAEM.

Connecting to SQL Server Express from a client machine

In Windows 2003, for a Rational System Architect client to connect to SQL Server
Express server, the TCP/IP protocol needs to be set on the server. If this is not done,
the client may get an "Error -2147467259" message when attempting to connect to the
setvet. To enable TCP/IP on a SQL Server Express setver, proceed as follows:

1. Click on Start -> Programs -> SQL Server Configuration Manager.

2. Select the SQL Server 2005 Network Configuration node.

3. Click on Protocols for SQLEXPRESS. The protocols are displayed on the right.
4. Right-click on TCP/IP and sclect Enable.

5. Close the SQL Server Configuration Manager.

Install Rational System Architect to the local machine of each User

Install SA to each client machine. You may also choose to install SQL Express to each
client machine in Rational System Architect’s Startup Wizard; SQL Express is necessary
if the user ever wishes to work on Rational System Architect models while off-line.
During installation of SA, you will be asked to specify the directory that holds the
License.dat license file.

Have users begin work

1. Start Rational System Architect: For a multi-user environment, the System
Administrator must run FLEXnet licensing on the network to provide an available
license slot for each user to work. Users working off-line on a stand-alone machine
must have a valid license of Rational System Architect.

2. Start Rational System Architect: Each user starts their individual copy of Rational
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System Architect. (Run Rational System Architect by selecting Start, Programs, IBM
Rational, Rational System Architect.) For machines onto which you have installed
SQL Express, SQL Express should automatically run as soon as the user starts their
machine. Users do not need a local instance of SQL Express running if they are
using an encyclopedia on the network; it is only necessary for users wishing to work
on an encyclopedia on their local machine.

Each user may begin by taking one of the on-line tutorials in the product, create a
new encyclopedia and begin working in Rational System Architect, or open an
encyclopedia specified by the Project Leader ot System Administrator.

The Startup Wizard attaches example encyclopedias to your server. You use some of
these example encyclopedias while taking Rational System Architect’s on-line
tutorials. If you changed the default settings of the Startup Wizard so that it did not
attach necessary example encyclopedias, you may attach them using SAEM. Each
tutorial covers how to do this. Tutorials are accessed by selecting Help, Tutorials.

or

Create a new encyclopedia from scratch and begin work on your own. To create a
new encyclopedia, consult the help — select Help, Help, and open the book Rational
System Architect — General, Using Rational System Atrchitect, Creating/Opening
Project Encyclopedias, Creating/Opening an SQL Setrver Encyclopedia.

or

Open an encyclopedia on the network specified by the System Administrator or
Project Leader.
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Il. Installations to SQL Express environments

Install Rational System Architect and SQL Express to network machine

1.

Install SA to a server machine on the network. During installation of SA, you will
specify a directory that will hold the License.dat license file. This directory must be
available to all Rational System Architect users; it will hold the license slots.

When you run Rational System Architect’s Startup Wizard, specify that SQL
Express get installed to the server machine (this is the default setting). The server
machine must have one of the following operating systems on it: Windows 2000, or
Windows XP.

System Administrator should tell users where the server is and what their
authentication method will be to create new encyclopedias on the server.

Install Rational System Architect to each user’s local machine

Install SA to each client machine. When running the Startup Wizard, you have the
option of installing SQL Express to the stand-alone machine; SQL Express is necessary
if the user ever wishes to work on Rational System Architect models while off-line.
During installation of SA, you will be asked to specify the directory that holds the
License.dat license file.

Have users begin work

1.

Start Rational System Architect: For a multi-user environment, the System
Administrator must run FLEXnet licensing on the network to provide an available
license slot for each user to work. Users working off-line on a stand-alone machine
must have a valid license for Rational System Architect.

Start Rational System Architect: Each user starts their individual copy of Rational
System Architect. (Run Rational System Architect by selecting Start, Programs, IBM
Rational, Rational System Architect.) For machines onto which you have installed
SQL Express, SQL Express should automatically run as soon as the user starts their
machine. Users do not need a local instance of SQL Express running if they are
using an encyclopedia on the network; it is only necessary for users wishing to work
on an encyclopedia on their local machine.

Each user may begin by taking one of the on-line tutorials in the product, create a
new encyclopedia and begin working in Rational System Architect, or open an
encyclopedia specified by the Project Leader or System Administrator.
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A. The Startup Wizard attaches example encyclopedias to your server. You use some
of these example encyclopedias while taking Rational System Architect’s on-line
tutorials. If you changed the default settings of the Startup Wizard so that it did not
attach necessary example encyclopedias, you may attach them using SAEM. Each
tutorial covers how to do this. Tutorials are accessed by selecting Help, Tutorials.

or
B. Create a new encyclopedia from scratch and begin work on your own. To create a
new encyclopedia, consult the help — select Help, Help, and open the book Rational
System Architect — General, Using Rational System Atrchitect, Creating/Opening
Project Encyclopedias, Creating/Opening an SQL Express Encyclopedia.

or

C. Open an encyclopedia on the network specified by the System Administrator or
Project Leader.
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I1l. Installations to Oracle environments

Make sure all Rational System Architect users have proper access rights to Oracle

This section details how to create a Rational System Architect encyclopedia on an
Oracle97 and Oracle 10g server. There is a one-to-one correspondence between a
Rational System Architect encyclopedia and a schema object in Oracle. The schema
object you create is given your user name by default, but you can also name it differently.
The owning user will have a default Tablespace whose name matches the schema object
name.

The user must have DBA and Connect privileges on the selected Oracle data source to
create encyclopedias. These privileges are not required to read encyclopedias.

To create and access Oracle encyclopedias, a Rational System Architect user must have
the Oracle OLEDB provider installed. The provider is a bridge that enables Rational
System Architect to communicate and work with an Oracle server. Rational System
Architect has been tested with OraOLEDB.DLL version 9.2.0.4.10 for Oracle 97 and
OraOLEDB10.DLL version 10.2.0.1 for Oracle 10g; other versions may or may not
work. Contact your Oracle DBA regarding the installation of the OraOLEDB.DLL.

You can access the Oracle database through the authentication method of the Windows
Operating System, or through the User Id and Password method provided by the Oracle
database. Once you establish a valid connection, you can switch over to the Schema
Object that contains the selected encyclopedia.
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Character Set for Oracle

It is recommended that you use the NLS_NCHAR_CHARACTERSET AL16UTF16 to
create encyclopedias in Rational System Architect propetly. You should use the
9.2.0.4.10 version of OraOLEDB.DLL for Oracle 97 and 10.2.0.1 version of
OraOLEDB10.DLL for Oracle 10g; otherwise, you will receive schema validation errors
upon opening an encyclopedia.

Each user will require the following minimum set of rights to access a Rational System
Architect Encyclopedia.

Select, Insert, Update and Delete on the following tables:

ENTITY CRITICALREGION
ERROR_LOG SINGLETHREAD
FILES FILES_HISTORY
IDGENERATOR ENTITY_HISTORY
SAPROPERTIES ENTITY_FLAGS
RELATIONSHIP

Execute on the following stored procedures:

CREATESNAPSHOT GETHISTORYLOGGINGSTATUS
ENTITYEXISTSBYID LOGENTITYHISTORYUPDATE
LOCKENTITYBYID LOGFILESHISTORYUPDATE
GETNEXTID PURGEHISTORY

GETFILESIZE SAVEAUDITSETTINGS
DELETEBYID SAVECHANGECONFIG

In addition to the above you also need to have granted permission CREATESESSION
to access an Oracle encyclopedia.
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When encyclopedias are created using Rational System Architect there are two settings
that can be specified in the ADO section of the SA2001.ini file, the first setting controls
the location of the file for each encyclopedias Tablespace. The second setting controls
the initial size of each encyclopedia’s Tablespace. 1f no settings are found in the
SA2001.1ni file then the physical file will be placed in the default location for the current
Oracle database and the initial size is set to 50MB. To override this behavior add values
to the sa2001.ini file as follows:

[ADO]
ADOOraxxxxxTablespacePath=C:\oracle\userdata\oracle9\
ADOOraxxxxxTablespaceSize=40

Where xxxxx should be replaced with the data source name that represents the Oracle
server and database as defined in the tnsnames.ora file. The path specification should
contain back slashes for Windows servers and forward slashes for Unix servers.

Note: the path specified must contain a trailing slash character or Rational System
Architect will present an error.

This is granted to the user by the System Administrator through SQL Server
Enterprise Manager (versions 2000 and 2005).

1. System Administrator should tell users where the server is and what their
authentication method will be to create new encyclopedias on the server.

Install Rational System Architect to the local machine of each User

Install SA to each client machine. You may also choose to install SQL Express to each
client machine in Rational System Architect’s Startup Wizard; SQL Express is necessary
if the user ever wishes to work on Rational System Architect models while off-line.
During installation of SA, you will be asked to specify the directory that holds the
License.dat license file.
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Have users begin work

1.

Start Rational System Architect: For a multi-user environment, the System
Administrator must run FLEXnet licensing on the network to provide an available
license slot for each user to work. Users working off-line on a stand-alone machine
must have a valid license of Rational System Architect.

Start Rational System Architect: Each user starts their individual copy of Rational
System Architect. (Run Rational System Architect by selecting Start, Programs, IBM
Rational, Rational System Architect.) For machines onto which you have installed
SQL Express, SQL Express should automatically run as soon as the user starts their
machine. Users do not need a local instance of SQL Express running if they are
using an encyclopedia on the network; it is only necessary for users wishing to work
on an encyclopedia on their local machine.

Each user may begin by taking one of the on-line tutorials in the product, create a
new encyclopedia and begin working in Rational System Architect, or open an
encyclopedia specified by the Project Leader or System Administrator.

a. The Startup Wizard attaches example encyclopedias to your server. You use some
of these example encyclopedias while taking Rational System Architect’s on-line
tutorials. If you changed the default settings of the Startup Wizard so that it did not
attach necessary example encyclopedias, you may attach them using SAEM. Each
tutorial covers how to do this. Tutorials are accessed by selecting Help, Tutorials.

or
b. Create a new encyclopedia from scratch and begin work on your own. To create a
new encyclopedia, consult the help — select Help, Help, and open the book Rational
System Architect — General, Using Rational System Atrchitect, Creating/ Opening
Project Encyclopedias, Creating/Opening an Oracle Encyclopedia.

or

c. Open an encyclopedia on the network specified by the System Administrator or
Project Leader.
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Roaming User Profiles

Rational System Architect supports Roaming User Profiles, which contain setting and
configuration information that enables users to retain their personalized settings even
when they log onto different machines on a network. SA stores user settings and
connection data to a folder that roams with the user, such as %ouserprofile%\ Application
Data.

By default, Roaming User Profiles are not enabled. Therefore, the SA2001.ini file (which
holds the configuration information described above) is placed in a local folder path, for
example C:\Documents and Settings\ <UserName>\Local Settings\ Application
Data\Telelogic\System Architect. Conversely, when Roaming User Profiles are enabled,
the SA2001.ini file is placed in the roaming folder path, for example C:\Documents and
Settings\ <UsetName>\Application Data\Telelogic\System Architect.

To enable Roaming User Profiles:

1. Open the Rational System Atrchitect installation path, usually C:\Program
Files\IBM\
Rational\System Architect Suite\11.3\System Architect.

2. Using your XML editor of choice, open the FilePaths.xml file.
3. Locate the ProfilePath Location node. The default setting is FALSE, as shown here:

<ProfilePath Location="" UseRoamingProfile="FALSE">
4. Change the UseRoamingProfile value to TRUE, as follows:

<ProfilePath Location="" UseRoamingProfile="TRUE">
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Installation instructions for upgrading to V11.3 and later

Beginning with Rational System Architect V10.3 new stored procedures and tables (for
history) are created and changes are made to existing stored procedures in all
encyclopedias (SQL Server 2000, SQL Server 2005, SQL Express, Oracle9i or Oracle
10g databases). To upgrade Rational System Architect V11.2 encyclopedias to V11.3 you
only need to open the V11.2 encyclopedias with Rational System Architect V11.3.

However, encyclopedias created with V10.1, V10.0, or V9 of the product must be
converted to V10.3 format before they can be automatically upgraded by V11.3. This is a
two-stage process:

Note: SAEM cannot perform standard functions on an encyclopedia residing on a
remote server.

Stage 1 — convert the data of the encyclopedia using SAEM, as follows:

1. Run Rational System Architect Encyclopedia Manager (SAEM) (select Start,
Programs, IBM Rational, System Architect Suite, SAEM).

2. In SAEM, log in to the server containing the encyclopedia you wish to upgrade
(select Server, Connect).

3. Choose the encyclopedia you wish to upgrade (select Database, Select Database).

4. 1In SAEM, select Tools, Convert to 10.3 Format. This will convert the data to the
format necessary to be used with Rational System Architect 10.3.

Stage 2 - A person with a System Administratot’s role, or the owner of the
encyclopedia, must open the converted encyclopedia in Rational System Architect V10.3
or later, as follows:

5. Find out who the owner of an encyclopedia is using SAEM (for SQL Express) or
Microsoft's Enterprise Manager (for SQL Server). Have that person or a person with
a System Administrator’s role, open the converted encyclopedia in SA V10.3 or
later.

6. Rational System Architect will automatically try to add new stored procedures and
tables to the existing encyclopedia when it is initially opened with SA V10.3 or later.
As long as a person with a Systems Administrator role or the owner of the
encyclopedia opens converted encyclopedia, the stored procedures will be propetly
created with an owner of 'dbo'.
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Upgrading Rational System Architect with upgrades and patches

IBM offers various upgrades to Rational System Architect that can be obtained by
contacting your sales representative or through the IBM Rational website www.ibm.com.

If you are installing an upgrade to Rational System Architect, it is not necessary to
uninstall the existing version of Rational System Architect. The upgrade will install over
the existing copy. Before downloading, please check the download page on the IBM
Rational Web Site to make sure you have the correct Rational System Architect version
number installed for the upgrade available to download.

Important: If you are installing an upgrade to Rational System Architect that you have
downloaded from the IBM Rational Web Site, you should not uninstall the previous
version of Rational System Architect; the downloaded upgrade looks for a previous
version of Rational System Architect on your machine, and will not install if the previous
version is not there.

Installing an upgrade

To install an upgrade to Rational System Architect, simply follow the same installation
procedures provided eatlier in this chapter for the type of licenses you have purchased.

Modifying, repairing, or removing Rational System Architect

The Rational System Architect Installation DVD enables you to modify the original
components of Rational System Architect that you installed, repair components that are
not working, or remove the program entirely. To perform any of the above tasks, do the
following:

1. Insert the Installation DVD into your DVD drive.
2. Run the setup.exe executable from the DVD.

3. Select Install Rational System Architect on the initial installation screen to launch the
InstallShield Wizard.

4. On the next screen of the wizard, select Modify, Repair, or Remove, as appropriate.

5. Rational System Architect can also be removed using standard Windows techniques
to remove a program (by selecting Add/Remove Programs in the Settings, Control
Panel).
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Summary of conversion instructions

You must convert encyclopedias created with previous versions of Rational System
Architect for use with V11.3. The conversion process is straightforward. The
Conversion Guide manual contains complete instructions for converting and it is
provided in .PDF format on the installation the Documentation DVD or in the Support
Web Site. If you do not have access to the Documentation DVD, please contact your
System Administrator.
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Silent installation

In addition to the standard installation options described earlier, you can also perform a
silent installation. A silent installation uses Microsoft Windows Installer (MSI)
Technology, enabling you to install Rational System Architect without entering the
necessary input in the dialog boxes. This is helpful to a Systems Administrator who
wants all the users, to whom he gives access, to carry out the same installation.

Requirement for Silent Installation of SA and SA DOORS Integration

As of this writing, to use the Silent install option for Rational System Architect and
Rational System Architect/ DOORS Integration requites that the Microsoft Windows
Installer 3.1 Service be installed on the operating system of the target computer. If it is
not present, the installation cannot continue and you are notified how to obtain and
install the Windows Installer 3.1.

All product options available for silent installation are exposed as public properties that
you can set on the Msiexec command line or through custom transform files. The
properties are as follows:

TLDESKTOPSHORTCUT ("Yes"/"No") - create a desktop shortcut -
default is "Yes"

TLMASTER ("Yes"/"No") - called from the Master Installer - default
iS "No"

TLUPGRADE (“Yes”/”No”) - called from the Master Installer - for
the auto -upgardation or to auto -uninstall and install the new
version

TLLICENSESERVER (string) - Licensing path from Master Installer
(if specified, may be null or undefined)

TLCLEAR ("Yes"/"No") - clear all user preferences, default is "No"
Older properties no longer supported are:

MASTERINSTALLDIR - (replaced by TLMASTER)

LICEENSESERVER - (replaced by TLLICENSESERVER)

CREATESHORTCUTS - (replaced by TLDESKTOPSHORTCUT)
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The following example illustrates the use of the options listed above:

msiexec /i SystemArchitect Enu 11.2.22.msi INSTALLDIR="C:\Program
Files\IBM\Rational\System Architect Suite"
TLLICENSESERVER="C:\SALicense\license.dat" LAPAGREE="No” /gb
TLDESKTOPSHORTCUT="Yes"

Note: The value for the TLLICENSESERVER property in the example above can also
be a license setver (e.g. TLLICENSESERVER="19353@server").

You can create MSI transforms if you need to specify many silent install options. For a
complete list of Command Line options for the Windows Installer, see Microsoft’s
MSDN Web Site:

http://msdn.microsoft.com/en-us/library/aa367988(VS.85).aspx.

The Windows Installer uses Msiexec. For more information on Msiexec, see Microsoft’s
TechNet Web Site:

http://technet.microsoft.com/en-us/library/bb490936.aspx).
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This chapter instructs you how to install IBM Rational System Architect XT™ and

2

related products. The chapter is partitioned into sections that cover different scenarios
of installing the product.

Introduction

Requirements for the Rational System Architect XT installer
1IS server requirements for SA XT

Requirements for the SA XT client PC

SA XT and SA integration

SA XT and IBM Rational SA Catalog Manager™ integration
Accessing encyclopedias with Rational System Architect XT
License requirements for SA XT and SA XT Web Service
Preparing to install the Rational System Architect XT software
Installing Rational System Architect XT

Veritying SA XT Web site properties in 1IS

Editing the web.config file

Folder permissions for the SA XT Domain Account

Testing the Rational System Architect XT Web site

Adding encrypted security to the Impersonation Account
Adding encrypted security to Oracle

Registering the NET Framework

Enabling Rational System Architect XT Web Service add-on product

Uninstalling Rational System Architect XT
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Introduction

IBM Rational System Architect XT is a web application that publishes an interactive
Web site of Enterprise Encyclopedias. Users can run custom or standard reports to get
real-time views of diagrams and definitions, and apply access control via role-based
views, among other features. Encyclopedias published on the Rational System Architect
XT Web site are created with IBM Rational System Architect®, and permissions to them
are administered by SA Catalog Manager.

IBM provides an optional add-on product, Rational System Architect XT Web Service,
which makes it easy for clients to publish Rational System Architect encyclopedia
information on their corporate intranet. The Web Service exposes SA XT methods,
providing consumer applications read-access to tepository objects they can use to run
Rational System Architect reports.
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SA XT installation overview

IBM provides full Rational System Architect XT installations only. This means that you
need to uninstall an old version of SA XT before you install a new version. Periodically,
service packs, patches ot hot fixes are made available on the IBM Rational support site
(http://www.ibm.com/software/rational/support/telelogic/) that will update your
existing version. You do not need to uninstall SA XT when you install a service pack,
patch or hot fix, unless otherwise instructed on the support site.

Rational System Architect XT installation

SA XT requites that the same version of Rational System Architect be installed on a
different computer on the network, as shown in the figure below. The Rational System
Architect XT installation also installs SA Catalog Manager. SA Catalog Manager can be
run from the SA XT machine (A) or from the computer in which standard Rational
System Architect is installed (C).

Standard PC

(with Supported Windows versions) —  SQL Server( Oracle
4 Running IS server
5
A
. 1 Server Security
[ SA Catalog Manager | (Windows Integrated authentication)

| Submit User Name
= 1 and Passward Authenticated
| System Architect/XT [ SAXT Domain Account -
J Read Enterprise
Publish Encyclopedig
Enterprise Encyclopedias
Enterprise Enterpri
Manage \| ) nterprise |
Enterprise Catalog eataloy Encyclopedi
http://MachineName/SAXT

Create/Edit
Encyclopedias
Standard PC

IIS Server Security P
(Windows Integrated authentication)
+ S !
’_. System Architect/XT Clients
[——

SA Catalog Manager * |

System Architect

* SA Catalog Manager is installed with SA and SA/XT

Note: An alternate configuration to that shown above is to install SA XT (A) on the
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same computer as the SQL Setver/Oracle database (B); such a configuration yields
optimum performance, but is not required. It is a best practice if the connection speed
between the encyclopedia server and the SA XT machine is less that 1 GB.
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Requirements for the Rational System Architect XT installer

The SA XT installer must possess administrative privileges on the computer in which he
or she is installing the software. Although SA XT automates much of the installation, it
cannot make the required changes without the following:

Administrative privileges on the SQL Server or Oracle servers where
encyclopedias (i.e. databases) are created. This is required for SA Catalog
Manager to create users, to grant them access to encyclopedias, and to assign
them roles on those encyclopedias (see below).

Permission to create a Domain Account on the network for SA XT to use. You
can also use existing account, if it has the required permissions. SA XT uses the
credentials of the Domain Account to connect to setvers (via Windows
Integrated authentication) where the catalogs and encyclopedias reside. The
Domain Account is also known as the ‘impersonation account—the SA XT
application “impersonates” the Domain Account (see pg. 47 for more
information).

Permission to create a Domain Account on the network that SA XT Web
Service can use. Note, the SA XT Web Service add-on can also use the same
Domain Account that is used by SA XT, or it can use different Domain
Account. Either way, the Domain Account for the SA XT Web Service has the
same requirements listed for SA XT above.
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IIS server requirements for SA XT

e Microsoft Internet Information Services versions 5.1 or 6.0 (this version has
some unique requirements, which are described below where applicable) —
Rational System Architect XT requires an internet server to host the SA XT
Web site through which users access Enterprise Encyclopedias.

e  Microsoft NET Framework version 2.0, with the latest available Service Packs.
If the SA XT installation does not find the .Net Framework, or it finds version
1.1, it will automatically install the NET Framework 2.0 without upgrading or
affecting version 1.1.

Hardware requirements

e 60 Mb of memory for the first user, plus 40 Mb for each additional user.

e 37 Kb of Desktop Heap allocation for each SA XT and SA XT Web Service
session. The amount of available Desktop heap in Windows is controlled by a
setting in the Registry. Desktop heap allocation is dependent on the anticipated
number of concurrent users. This setting lets you increase the default number of
concurrent users allowed, which is twelve (see pg. 53 for more information).

e High-speed network connection between the SA XT server and the SQL or
Oracle Database server.

Operating System and Software requirements
Rational System Architect XT requires one of the Microsoft Windows operating systems
below:
e Windows 2000 (with Service Pack 4)
e  Windows XP
e Windows Server 2003 (32-bit version)

e  Microsoft’s NET Framework version 2.0 with the latest available Service Packs
(will auto-install if not present or if an older version is found).

e The Microsoft Internet Information Services — if 1S is already enabled in the
operating system, SA XT configures it accordingly. Otherwise, you need to
enable 1IS in the operating system (see pg. 36 for more information).
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Requirements for the SA XT client PC

Microsoft Windows 2000 or XP (with Service Pack 2)
Microsoft Internet Explorer 6 or Mozilla Firefox 3.0

Java Runtime Environment — the minimum version required is JRE 1.5. The
JRE enables SVG graphics to be displayed via the Java-based SVG viewer
applet (from Batik). At run-time, if SA XT finds that the JRE is not installed, a
dialog will inform you that you need to install it and provide a link to the Web
site from which you can download it.
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SA XT and SA integration

Rational System Architect XT works with Rational System Architect. In SA, users create
encyclopedias, which are databases on SQL Servers or Schemas in an Oracle database.
When encyclopedias are shared among multiple users, access to them is controlled via
SA Catalog Manager. Such encyclopedias are classified as Enterprise Encyclopedias. An
SA XT Web site publishes Enterprise Encyclopedias. An encyclopedia that is 7o#
attached to an Enterprise Catalog is classified as a Professional Encyclopedia; this type
may be shared amongst users, but cannot be published by SA XT.

SA XT and SA Catalog Manager integration

The SA Catalog Manager utility is installed by Rational SA and Rational System
Architect XT. SA Catalog Manager controls access to Enterprise Encyclopedias. On
each server, SA Catalog Manager creates an Enterprise Catalog. The catalog
administrator who creates the catalog becomes its owner, can add users to the catalogs,
and determine which encyclopedias users can view. Optionally, the admin can select the
encyclopedia artifacts a user can view.

When a user on a client machine browses the SA XT Web site, he or she must select an
encyclopedia server. The SA XT setver (on 11S) then reads the catalog on the selected
server. The catalog detects the encyclopedias the user is allowed to view on that server
and displays them in a drop-down list. When the user selects an encyclopedia, the catalog
filters the encyclopedia artifacts that that user can view based on his or her assigned role.

See chapter 3 of this installation guide or SA Catalog Manager’s online help for more
information on Enterprise Catalogs.

Accessing encyclopedias with Rational System Architect XT

To view or edit encyclopedias through the Rational System Architect XT Web site, you
need the same permissions as you do with standard Rational System Architect. In other
words, an individual must exist as a user in the catalog, and at login, supply his or her
DomainName\UserName combo and password to view encyclopedias. If you are
already logged into the domain when you launch SA XT, you will not be prompted to
enter your log in credentials.

Another requirement to access an encyclopedia through the SA XT Web site is that its
property configuration files are up-to-date. This is achieved by simply opening an
encyclopedia with a Rational System Architect version that is the same version as SA
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XT. Doing so compiles the property file and brings it up to date. If you do not perform
this step, the encyclopedia is considered out-of-date, and users will be unable to open it.
Therefore, opening encyclopedias with a standard copy of Rational System Architect
should be considered a part of any installation, upgrade, or service pack that you apply.

Server Roles and Permissions

The SA XT Domain Account (i.e., impetsonation account) needs the same connection
privileges and access to the encyclopedia server, and to the to the Enterprise Catalog as
typical System Architect users. Therefore, you must grant the Domain Account
appropriate rights on each server you wish to access. The roles, encyclopedia access and
catalog access are described in L. Installations to SQL. Server environments section on page 11.
For more detailed information on permission to encyclopedia catalogs, see the 3 - Sez #p
User rights to Encyclopedias section on page 73.
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License requirements for SA XT and SA XT Web Service

SA XT does not support node-lock licensing. You must use a license from a License
Server because SA XT limits the number of user sessions that it runs based on the
number of licenses purchased. A License Server is required to keep count of the number
of licenses in use at any one time.

The default SA XT login page contains a radio button where you choose to login as a
Reader or as an Updater. A Reader uses one “SA-XT” license, plus one “SA-XT Read
Only” license. An Updater uses one “SA-XT” license, plus one “SA-XT Read-Write”
license. An SA XT Web Service session uses one SA-XT license plus one SA-XT -
WebService license. This is summarized in the table below.

Product License(s) used

SA XT Read Only SA-XT + SA-XT-Read

SA XT Read-Write SA-XT + SA-XT-Read-Write
SA XT Web Service SA-XT + SA-XT-WebService

See the Rational System Architect Installation Guide for more detailed information on
setting up and accessing licenses from a license server. You can find the Rational System
Architect Installation Guide on the Documentation DVD of your installation package,
ot you can download it from the IBM Rational support site—
http://www.ibm.com/software/rational/support/telelogic/.
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Automated Rational System Architect XT installation tasks

Rational System Architect XT is based on Microsoft’s ASP.NET technology, which is
part of the NET Framework. To create the Web site and manage access to it, the SA
XT installation enables and configures those Windows services and components that it
needs to publish the SA XT Web site. The components SA XT configures are as

follows:

Microsoft Internet Information Services (IIS) 5.1 or higher - creates and
configure a Virtual folder for the SA XT Web site.

Directory Security - enforces security for the SA XT Web site through
Integrated Windows authentication. This checks the identity credentials that
users submit before they are allowed to access the secured Web site content.

Enables .SVG graphic support by configuring IS and installing the Java applet
to view .SVG files. Installation of the Java applet requires that the Java Runtime
Environment be installed; if it is not, you can install the JRE and configure
.SVG support manually.

Creates 2 Windows User Account (also referred to as the “Domain Account”).
At installation time, you can choose the name (in the form
DomainName\UsetName) and a password for this account. The account is
granted permissions to select folders. You can use an existing account, as long
as it has required permissions.

Preparing to install the Rational System Architect XT software

Before your install Rational System Architect XT, it is recommended that you backup
and are able to restore the following Windows components, which the SA XT
installation may modify:

1IS Metabase -- the installation process may update the 1IS Metabase.

To find IIS Metabase backup documentation go to:

http://www.microsoft.com/windowsserver2003/community/articles/a
rt iismetabak.mspx

Windows Registry — if you need to increase the number of concurrent users, or
to add encrypted password security after the installation completes, you will
need to edit registry.
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To find Registry backup documentation go to:

http://support.microsoft.com/kb/322756

Checking that Internet Information Services is installed

If the Windows IIS component is not enabled in the computer where SA XT is to be
installed, you can enable it manually as follows (provided you have the proper privileges).

1.
2.
3.

® x>,

Click Control Panel and select Administrative Tools.
Click the Internet Information Services icon, and go.

If you see the Internet Information Services icon, it means that the computer has
11IS installed and enabled.

If you do not see the Internet Information Services icon, you need to install it as
follows.

Click on the Control Panel.
Click on Add or Remove Programs icon.
Click Add/Remove Windows Components.

Toggle on Internet Information Services (1IS), and click Next to complete the
Wizard.
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Installing Rational System Architect XT

1.

To install Rational System Architect XT proceed as follows.

- If you downloaded the software from the IBM Rational Web Site, double-click on
the executable file you downloaded to run the installation.

- If you received an installation DVD from IBM, insert your Rational System
Architect Installation DVD into your DVD-drive. The auto-run interface is
launched and The IBM Rational Lifecycle Solutions screen appears. Click on the
Install link for IBM Lifecycle Solutions Clients.

In the ‘Welcome’ screen, click Next to begin the installation.
Follow the instructions provided the Installation Wizard.

When the wizard gets to the Impersonate Login screen, , enter your User Name
and Password values as shown below. SA XT submits these values to login to SQL
or Oracle encyclopedia servers.
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IBM Rational System Architect XT - InstallShield Wizard

Impersonate Login

Thiz account will be uzed to run 54527 website.

User Name : DramainM amehU ser ame

Eq: Domain namehl zer name

Pazsword ! T |

Mate: The pazsword entered above will be written to the web config file in clear text format.
Fleaze refer to the installation guide for instructions on how to encrept this password.

|lze the above user name and pazsword for databaze login,

Maote: The uzer must still grant this account sufficient rightz on the databaze
SEMVEL

< Back ]MEHD |[ Cancel

The checkbox Use the above user name and password for database login
option works as follows:

If you enable the option, SA XT uses Windows Integrated Security to login to SQL
database server. It will not work with Oracle. As by default, MS SQL Server only
allows login via Windows Integrated Security, this option should normally be
checked if using SQL Server. By default, Oracle database server will not accept such
logins, so the option should not be checked. If in doubt, ask your Database
Administrator what type of user authentication is used.

If you do not enable the option, and click Next, the Database Login dialog is
displayed, as shown below. In this dialog, enter the User Name and Password
credentials to login to Oracle or SQL databases, and click Next. Note, the user must
be defined to use SQL Authentication if you use this option for SQL Server. This is
also true for Oracle, but Oracle authentication is the default method for Oracle.
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IBM Rational System Architect XT - InstallShield Wizard

Databaze Login

The 54T web zite will connect to the databage zerver Lzing this account,

Uzer name : i tyOraclel zert ame |

Eg: User name

FPazawiord I |

Maote: The uger must still grant this account sufficient rights on the databaze
SEIVEL

The paszword entered abowve will be wnitten to the web.config file in clear text
format. Pleaze refer bo the installation guide for instructions on how to encrypt
thiz pazsword.

< Back ]ueww |[ Cancel
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5. Click Next.
6. In the Start Copying Files dialog, click Next.
7. Click Finish in the InstallShield Wizard Complete dialog,.

If you purchased either the DoDAF-ABM or DoDAF (c4ist) features, open the
installation folder (C:\Program Files\IBM\
Rational\System Architect Suite\1ll.3\System Architect) and perform the
appropriate file copy operation as follows:

e  For DoDAF-ABM, copy:

sadeclar.abm to sadeclar.cfg
autoexec.abm to autoexec.sty

For DoDAF(cdisr), copy:

sadeclar.c4 to sadeclar.cfg
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Verifying SA XT Web site properties in lIS

Before users logon to the SA XT Web site, or if they are having problems viewing the
Web site, you can verify that your Web site properties in IIS are set up as required.

1.

1 - Checking and

Click on Start > Settings > Control Panel > Administrative Tools > and select
Internet Information Services.

Expand the local computer node. This is usually indicated by your computer name,
for example ComputerName (local computer).

Expand the Web Sites folder and then the Default Web Site node.
Right-click on the new SAXT Web site and select Properties.

You can use the procedures below to verify that your SA XT Web site is setup
correctly.

1 - Checking and configuring ASP.NET mapping
2 - Setting directory security manually

3 - Set the default page for SA XT Web site

4 - Verifying that the .SVG MIME type is present

The procedures above are detailed in the sections that follow.

configuring ASP.NET mapping

On the Virtual Directory tab, click the Configuration... button.

On the Mappings tab, locate the .aspx entry in the Extension column. The
Executable Path column for this entry should display

C:\Windows\Microsoft .NET\Framework\
v2.0.50727\aspnet_isapi.dll.

If the .aspx entry appears and it contains the above values for the Executable
Path, then click OK and proceed to next section “Setting ditectory security
manually.” If the .aspx entry does 7ot appear, it means SA XT is not mapped to the
correct ASP.NET version. In this case, click Cancel to return to the Virtual
Directory tab. You need to map SA XT to the correct version of ASP.NET as
described in the “Registering the NET Framework™ section on page 59.
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2 - Setting directory security manually

1. Click on the Directory Security tab.

2. In the Anonymous access and authentication control group box, click Edit.
3. Check the Integrated Windows authentication.

4. Uncheck all other checkboxes and click OK.

Authentication Methods

Mo user name/pazaword required to access this resounce.

Accaunt used for anonymaus access:

Uszer name:

Pazswaord:

Authenticated access

Far the following authentication methods, uzer name and passward
are reguired when

- ahonymous access iz dizabled, or

- access iz resticted using NTFS access control listz

[ ] Digest authentication for ‘Windows domain servers

[]Bazic authertication [pazsword iz sent in clear tewt]

Defaulk domain;

[ntegrated *Windows authentication

[ )4 ] [ Cancel ] [ Help ]
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3 - Setting the default page for SA XT Web site manually

1. Click the Documents tab.

2. Make sure Enable Default Document checkbox is checked that the file name
Default.aspx appears in the list.

3. If the Default.aspx does not appear on the list of files, click Add.
4. Enter Default.aspx and click OK.

5. Select the Default.aspx file and use the Up button to move the file to the top of

the list.
SART Properties
| HTTF Header=s l Cuztom Errors || ASPMET |
| Wirtual Directary | Documents | Drirectary Security |

Enable Default Document

) efault aspx Add...
;

[] Enable Document Faater

[ k. ] [ Cancel ] [ Apply ] [ Help
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4 - Verifying that the .SVG MIME type is present

SA XT uses the .SVG file format to display diagrams and charts. If diagrams do not
display correctly, you can check that the SVG setting in 1IS is setup propetly.

1.
2.
3.

Click on the HTTP Headers tab.
In the MIME Map group click the File Types... button.

If the Registered file types field already contains the value .svg
images/svg+xml, click Cancel, and proceed to the next section. If .SVG is not
displayed in the list, click the New Type button.

Enter .svg in the Associated extension field, and enter image / svg+xml in the
Content type (MIME) field, and click OK.

File Type E3

Azzociated extension: | -EVQ |

Contert type [MIME]: | image/svg+sml |

[ Ok ][ Cancel ]

In the File Types dialog, the Registered file types ficld should now contains the
value .svg image/svg+xml. Click OK.

On the main SAXT Properties dialog, click OK to return to the IIS Admin tool.
In the IIS Admin tool, click File > Exit.
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Editing the web.config file

Edit the web.config file to enter the User Name and Password for the SA XT
Impersonation Account. You only need to do this if you want to change the User Name
and password that you entered during the SA XT installation. The web.config file is
located in the SA XT installation folder, usually

C:\Program Files\IBM\Rational\System Architect Suite\1l1l.3\SAXT.
1. Open the web.config file with any text editor.

2. Update the userName and password attributes of the identity element with your
new User Name and Password values. Substituting your actual values, the identity
element should appear like this:

<identity impersonate="true" userName="DomainName\UserName"
password="password"/>

3. Save and close the web.config file.

Note: If you are concerned about storing the User Name and Password with clear text,
see the “Adding encrypted security to the Impersonation Account” section on

page 55.
IIS 6.0 only - set lIS to use NTLM authentication

You should read this section only if you are installing SA XT to an IIS 6.0 server. In
such an environment, you may need to configure NTLM manually with Integrated
Windows authentication as the authentication mechanism.

If you use IIS v. 6.0 and your SA XT server does not work properly, you may use the
steps below to check your security settings are propetly set up.

1. Click Start > Run, type cmd in the Open field, and click OK.
2. Open the directory C:\InetPub\Adminscripts.

3. Type the following command and press Enter:
Cscript adsutil.vbs get w3svc/NTAuthenticationProviders
No further action is required if the command returns:
NTAuthenticationProviders: (STRING) "NTLM.”

If it does not return the above, proceed to step 4 below.
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4. From the command prompt, run the following command:
Cscript adsutil.vbs set w3svce/NTAuthenticationProviders “NTLM”

5. Repeat step 3 above to confirm the setting has been corrected.

Adding Oracle authentication for SA XT and SA XT Web Service

Note: You can enter the login credentials for Oracle databases at install time through

the Rational System Architect XT Installation wizard. The information that follows is
provided to enhance the usability of this installation guide. You may use as a reference or
for troubleshooting purposes.

Rational System Architect XT and the SA XT Web Setvice support Oracle
authentication to access encyclopedias in Oracle databases. You can also use the default
integrated windows authentication. To enable Oracle database security, the web.config
files for SA XT and for SA XT Web Service contain two items in the connectionStrings
section. The items are DBUser and DBPassword. 1f the connectionStrings value of the
DBUser item is not empty, the system will attempt to connect to the selected server
using the values provided in the connectionStrings fields. If the connectionStrings value of
the DBUjser item is empty, the system will continue to use windows integrated
authentication when it connects to the database server.

The following example forces the SA XT or SA XT Web Service to connect to the
database server with the User Name OracleSAXTW ebUser and the password
OracleSAX Tpwd.

<connectionStrings>
<add name="DBUser" connectionString="OracleSAXTWebUser" />
<add name="DBPassword" connectionString="OracleSAXTpwd" />

</connectionStrings>

You can access your Oracle encyclopedias by using the clear text settings above, or you
can add another layer of security through encryption. To add encryption to Oracle
authentication, see the “Adding encrypted security to Oracle authentication” section on

pg. 57.

48 Rational System Architect and Rational System Architect XT Installation Guide



Installing Rational System Architect XT

Folder permissions for the SA XT Domain Account

The account for the User Name that you enter during the installation is granted “Tull
Control” permission to certain folders. This allows SA XT to create temporary files for
SA XT sessions. The folders and permissions that SA XT requires for them are
described in the sections that follow.

Rational System Architect temporary folders

The SA XT installation creates a folder named "System Architect” in the C: \Program
Files\IBM\Rational\System Architect Suite\11.3 subfolder. The System
Architect folder contains a file named FilepPaths.xml. This file contains an element
named ProfilePath, which has a single empty attribute named Location. This
attribute allows you to specity the path for the temp folder that should be used instead
of the default path set for impersonation account, as determined by the operating
system. For example, if you set the Location attribute value to “C:\saxt” System
Architect creates temporary folders in the “c:\saxt” folder, on each uset's machine. If
the folder you specify does not exist, SA will create it for you.
<FileLocations>

<ProfilePath Location="C:\SAXT">

</ProfilePaths>
<FileLocations>

Rational System Architect XT temporary folders

The web.config file (located in the SA XT installation folder, usually C: \Program
Files\IBM\

Rational\System Architect Suite\11l.3\SAXT) contains the TempFolder in the
AppSettings Key. This key/value pair enables the administrator to determine the root
folder that SA XT uses to create temporary files. The web.config file does not contain a
value for the TempFolder key. By default, SA XT uses the folder returned by the
operating system.

The example below forces SA XT to use “C:\SAXT” as the root folder for temporary
folders:

<appSettingss>

<add key="TempFolder" value="C:\SAXT">
</appSettings>
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Folders and file(s) that require the Full Control permission

SAXT grants the Full Control permission to the following folders:

C:\Documents and Settings\Default User\Local Settings\Application
Data\Telelogic\System Architect

C:\WINDOWS\Microsoft .NET\Framework\v2.0.50727\Temporary ASP.NET
Files

C:\Windows\Temp

C:\Windows\System32\Config\Systemprofile (or FilePaths.xml
ProfilePath Location setting)

C:\Program Files\IBM\Rational\System Architect Suite\1l1l.3\System
Architect\sa2001.log

C:\Documents and Settings\<machinename>\ASPNET\Local Settings\Temp
(or web.config TempFolder setting)

Note: If a NET application has never been run on the SA XT machine, it’s possible

the following subfolder may not exist:

C:\Documents and Settings\<machinename>\ASPNET\Local
Settings\Temp

If it does not exist, grant permission to other folders first (as described below)
then test the Web site. This will create the missing Temp folder. Afterwards,
return to the newly created Temp folder and grant it the Full Control permissions,
as described in the section that follows.

Granting Full Control to required folders manually

The Rational System Architect XT installation grants the Full Control permission to the
folders described above automatically. However, if you need to grant the permissions to
those folders manually, proceed as follows:

1.
2.

In Windows Explorer menu, click Tools >Folder Options >View tab.

Check the show hidden files and folders field, if it is not checked, to ensure you
can see the folders and files to which you need to grant permission.

With Windows Explorer, locate the folder you are granting the Full Control
permission to, and click on it once to select it.

Right-click on the folder and select Properties > Security tab.
Click the Add button, enter the name of the Domain Account, and click OK. The
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account should now appear on the Group or user names field.
6. Click once on the account to select it.

7. In the Permissions for Users group, click on the Allow checkbox for the Full
Control property.

8. Repeat steps 3-8 for each folder that needs the Full Control permission.

Testing the Rational System Architect XT Web site

If your SA XT Web site is not working properly, perform the checks below. These
checks help you ensure that the SA XT software is running successfully in the 1IS server,
that it can access encyclopedias on the SQL Server or Oracle servers, and that Windows
Desktop Heap allocation are all properly configured.

Checking that SA XT starts on the IIS server

After you make changes to the Web site, IIS needs to be reset, or restarted, for the
changes to take effect. It is recommended that you run the IISReset command from a
DOS prompt, as follows.

1. Click Start > Run, type cmd in the Open field, and click OK.
2. Type iisreset, and press Enter.

3. The command above stops and restarts the 1IS. When completed, you should
receive a confirmation message that Internet Services Successfully Restarted.
Close the DOS window.

4. Launch Internet Explorer and enter the following URL:
http://<machinenames>/saxt

5. If the Rational System Architect XT Login page is displayed, close Internet
Explorer. Installation was successful.

On some servers, you may need to run SA XT manually prior to using SA XT. On these
servers, a registry update may occur when SA XT is run for the first time on a clean
machine. To ensure SA XT starts on the server, navigate to the SA installation folder,
usually C:\Program files\IBM\Rational\System Architect Suite\11.3\System Architect,
and double-click on sa2001.exe. SA XT does not present a UI when started in this
manner. However, you can see if SA XT started successfully by looking in the Windows
Task Manager. If started, you will see a process running for SA2001.exe. To shut down
the SA XT session, select sa2001.exe process and click on End Process.
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Adding DCOM Rights to Impersonation account and INTERACTIVE Group

When the Rational System Architect X'T impersonation account is not a local
administrator on a Windows 20003 or a Windows XP machine, you may receive an
‘Error starting SA2001” message. If so, you may need to set DCOM permissions
manually for the impersonation account and the INTERACTIVE group as follows:

1.

Nl

q s, R

10.
11.

Have users who are logged onto Rational System Architect XT log off and shut
down the application.

Click Start > Programs > Control Panel > and select Administrative Tools.

Click on Component Services, and expand the following nodes: Component
Services > Computers > My Computer.

Click on the DCOM Config node and expand it.
Find SA2001.Lexus, right-click on it, and select Properties.
Click on the Security tab.

Under Launch and Activation Permissions, click on Customize and on the Edit
button. In the Launch Permission dialog, the impersonation account and the
INTERACTIVE Group must be added to the list of Group or user names field.

Click Add, select the impersonation account and the INTERACTIVE Group, and
click OK.

In the Security tab, make sure that the impersonation account and the
INTERACTIVE group have Allow set for all four permissions.

Click OK twice and exit the Component Services.

Restart Rational System Architect XT.
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Checking that SA XT can access encyclopedias on a server

To work propetly, SA XT must be able to access the SQL Servers or Oracle setvers
through the Impersonation Account. Use the steps that follow to confirm that SA XT
can access those servers to publish the encyclopedias within them for SA XT clients.

1. Launch Internet Explorer and enter the following URL:
http://<machinename>/saxt.

2. Select to login as a Reader or Updater, and click Login.

3. In the Enter or select a setver page, select a server type from the Server Type
drop-down list. You can accept the default server, SQL Server or click on the drop-
down to select Oracle instead.

4. In the Server Name field, enter the name of the server with the catalog that has
Enterprise Encyclopedias attached to it. For example, NYC\SQLServer.

5. Click GO. SA XT reads the catalog on that server in order to populate the
encyclopedia list that users can select from.

6. Click the Encyclopedia Name drop-down list, select an encyclopedia, and click
Open. You should now see the SA XT Introduction page, with following URL
displayed in the browset’s address bar: http://<machinename>/saxt/pagegen.aspx.

Windows Desktop Heap allocation

The SA XT installation sets the Windows registry to allocate enough space for twelve
concurrent users. By default, each session of SA XT uses up to 37 KB of a single non-
interactive Windows Desktop Heap. The SA XT installation does not change this
setting, but you can change it as necessary as describe below.

In Windows, the amount of Desktop Heap available can be modified in the following
registry subkey:

HKEY LOCAL_ MACHINE\System\CurrentControlSet\Control\Session
Manager\SubSystems\Windows

The default value for this subkey usually looks like the following:

$SystemRoot%\system32\csrss.exe ObjectDirectory=\Windows
SharedSection=1024,3072,512 Windows=0On SubSystemType=Windows
ServerDll=basesrv,1l ServerDll=winsrv:UserServerDllInitialization, 3
ServerDll=winsrv:ConServerDllInitialization,2 ProfileControl=0ff
MaxRequestThreads=16

The sharedSection entry in this subkey controls the number of KBs allocated to each
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of three different types of Desktop Heaps. SA XT uses the third value (512) in the
SharedSection. In this example, the system will allocate 512 Kb of space for all the SA
XT sessions to share, which will allow 12 sessions of SA XT to be run concurrently.

512 / 37 - 1 = 12

Modifying this value can impact other applications running on the same machine.
Therefore, it is recommended that if you choose to modify the value in this subkey that
you first read the following document on the Microsoft Web site:

http://support.microsoft.com/default.aspx?scid=kb;EN-US;184802

The SA XT web. config file (located in the SA XT installation folder, usually
C:\Program Files\IBM\Rational\System Architect Suite\SAXT) contains an
appSetting entry that must be set to match the value in the registry. The key
MaxDesktopHeap should have its value set to the same value specified in the registry.
This web . config entry allows SA XT to ensure that users do not attempt to start
sessions that would cause this allocation to be exceeded.

<appSettings>
<add key="TempFolder" value="">
<add key="MaxDesktopHeap" value="512">
</appSettings>
If you use the SA XT Web Service feature, it will be allocated its own instance of the
non-interactive Windows Desktop Heap. All specifications described above for SA XT
also apply to SA XT Web Service. The SAXTWebService web.config file also contains
an appSetting entry that must be set to match the value in the registry. The key
“MaxDesktopHeap” should have its value set to the same value specified in the registry.

This web.config entry allows SAXTWebService to ensure that users do not attempt to
start sessions that would cause this allocation to be exceeded.

<appSettings>
<add key="MaxDesktopHeap" value="512"/>
</appSettings>
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Adding encrypted security to the Impersonation Account

The process described in this section is optional. Its purpose is to enable you to add a
greater level of security to the SA XT Impersonation Account (also know as the Domain
Account). By default, the account’s ID and Password, as configured in web.config file
are stored in clear text (in the web.config file), which is not as secure as encrypted text
(see “Edit the web.config file” on page 47). Microsoft provides the ASP.NET
Encryption Tool, which lets you encrypt the id and password values, making them more
secure.

You can download the encryption tool, along with instructions on how to use it, from
the following url:

http://support.microsoft.com/default.aspx?scid=kb;en-us;329290

Securing the Impersonation Account is a three-phase process, described in the following
sections.

1 - Updating the Windows registry

Before performing this procedure, you must back up the registry and have a restore
procedure if a problem occurs. This is particularly important because securing the
Impersonation Account modifies the Windows registry.

To run the ASP.NET Encryption tool, proceed as follows:
1. Click Start > Run, type cmd in the Open field, and click OK.

2. Go to the folder into which you downloaded and unzipped the aspnet_setreg.exe
file.

3. Type the following command, substituting the "domain\username" and "password"
values with your actual values:

Aspnet setreg -k:SOFTWARE\saxt\identity -u:domain\username -
p:password

4. Press the Enter key. The following keys are created in the registry:
HKEY_LOCAL_MACHINE\SOFTWARE\saxt\identity\ASPNET_SETREG,us
erName

HKEY_LOCAL_MACHINE\SOFTWARE\saxt\identity\ASPNET_SETREG,pa
ssword
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2 - Updating the web.config file

Once the registry has been updated, as described above, you must update the Identity
element of the web.config file to reflect the values created for this account. The
web.config file is located in the installation folder, usually

C:\Program Files\IBM\Rational\System Architect Suite\SAXT folder. You
must modify the Identity element to appear exactly as shown here, including letter case:

<identity impersonate="true"
userName="registry:HKLM\SOFTWARE\saxt\identity\ASPNET SETREG, userN
ame"
password="registry:HKLM\SOFTWARE\saxt\identity\ASPNET SETREG, passw
ord"/>

3 - Granting permission to the Aspnet_wp.exe process

You must then make sure to grant read permissions to the Aspnet_wp.exe process
account, which is usually <machinename>\ASPNET, as follows:

1.

2
3.
4

Click Start > Run, type regedit in the Open box, and click OK.
Expand the HKEY_LOCAL_MACHINE >SOFTWARE > SAXT >identity
Right-click ASPNET_SETREG and select Permissions.

Click Add. In the dialog box that opens, add the object name based on the servers
operating system, as follows:

If the server is on Windows XP, type

<machinename>\ASPNET

If the server is on Windows Server 2003 (which runs IIS 6.0), type:
<machinename>\NetWorkService

Click OK.

On the Security tab, check on Read permission to the account in the step above,
and click OK.

Close the Registry Editor.
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Adding encrypted security to Oracle authentication

The information in the connectionStrings section can be encrypted with standard Microsoft
utilities. The section below provides a summary of Machine-Level Key encryption
method, which is one of the various methods available. You can find the complete text
for this encryption method at the following Microsoft page:

http://msdn2.microsoft.com/en-us/library/ms998283.aspx#paght000006_step?2.

The process described below can be use to encrypt the web.config of SA XT or SA XT
Web Service.

Encrypting Oracle Authentication with Machine-Level Key:

1. Click Start > Run, type cmd in the Open field, and click OK.
2. Go to the folder that contains the Microsoft aspnet_regiis utility and execute the

following command:

CAWINDOWS\Microsoft. NET\Framework\v2.0.50727>aspnet_regiis -pef
"connectionStrings" “C:\program files\ibm\rational\system architect suite\saxt”

You should receive the following message if the utility was successful:

Encrypting configuration section...
Succeeded!

When you use the Machine-Level Key encryption, the RSA machine key containers are
stored in the following folder:

C\Documents and Settings\All Users\Application
Data\Microsoft\Crypto\RSA\MachineKeys

The SAXT impersonation account needs read access to the file created in the folder
above. To grant the required access rights proceed as follows:

3. Click Start > Run, type cmd in the Open field, and click OK.

4. Go to the folder that contains the Microsoft aspnet_regiis utility. Substituting the
“domain” and “user” values below with your actual “domain” and “uset” names,
execute the following command:
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C:\WINDOWS\Microsoft .NET\Framework\v2.0.50727>aspnet_regiis -pa
"NetFrameworkConfigurationKey" "domain\user"

You should receive the following message if the utility was successful:
Adding ACL for access to the RSA Key container...
Succeeded!

Decrypting Oracle Authentication with Machine-Level Key :

To decrypt the connectionStrings section of the web.config file proceed as follows:
1. Click Start > Run, type cmd in the Open field, and click OK.

2. Go to the folder that contains the Microsoft aspnet_regiis utility and execute the
following command:

C:\WINDOWS\Microsoft. NET\ Framework\v2.0.50727>aspnet_regiis -pdf
"connectionStrings" “\program files\ibm\rational\system architect suite\saxt”

You should receive the following message if the utility was successful:

Decrypting configuration section...
Succeeded!

When using Machine-Level Key encryption the RSA machine key containers are stored
in the following folder:

C:\Documents and Settings\All Users\Application
Data\Microsoft\Crypto\RSA\MachineKeys

To remove the access rights given to the SAXT impersonation user, switch to the folder
proceed as follows:

3. Click Start > Run, type cmd in the Open field, and click OK.

4. Go to the folder that contains the Microsoft aspnet_regiis utility. Substituting the
“domain” and “user” values below with your actual “domain” and “uset” names,
execute the following command:

C:\WINDOWS\Microsoft .NET\Framework\v2.0.50727>aspnet_regiis -pr
"NetFrameworkConfigurationKey" "domain\user"

You should receive the following message if the utility was successful.

Removing ACL for access to the RSA Key container...
Succeeded!
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You must restart 1S after updating the ACL
Click Start > Run, type cmd in the Open field, and click OK.
Type IISReset.

You should receive the following message if the utility was successful.

Attempting stop...
Internet services successfully stopped
Attempting start...
Internet services successfully restarted

Registering the .NET Framework

The Rational System Architect XT Installation Wizard automatically installs Microsoft’s
Net Framework. Perform the steps below if you need to verify whether the ASP.NET
version 2.0 ISAPI filter have been set up correctly.

1.
2.

Click Start > Settings > Control Panel > Internet Information Services.

Expand the local computer node (which is usually indicated by your computer
name) and expand Web Sites.

Right click the Web Sites folder and select Properties.

On the ISAPI Filters tab, make sure the list contains an entry for
ASP.NET_2.0.50727.42 (if the NET 2.0 Framework has been installed). If this is
present, it means that ASP.NET has been installed correctly, and that you can exit
I1S.

If ASP.NET is not present, it is possible that the .NET Framework has not been
installed, or that IIS was installed after the NET Framework. If IIS was installed
after the NET Framework, there may be a problem with script maps, which you can
repair with the ASP.NET IIS Registration tool. Typically, the tool
(Aspnet_regiis.exe) is located in

C:\windows\Microsoft .NET\Framework\v2.0.50727. However, before running
this tool, you should consult with your Systems Administrator and carefully read the
documentation at the following Microsoft Web site:

us/cptools/html/cpgrfaspnetiisregistrationtoolaspnet regiisexe.asp
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For SA XT, in a test environment where IIS was installed after the NET Framework,
the Registration tool was used with the following command:

C:\windows\Microsoft .NET\Framework\v2.0.50727->aspnet _regiis -ir

This installed ASP.NET version 2.0.50727 without updating all script maps. After
installing SA XT, the following command was run:

C:\windows\Microsoft .NET\Framework\v2.0.50727->aspnet_regiis -s
W3SVC/1/ROOT/SAXT

This installed ASP.NET version 2.0.50727 at the specified application root and its
subfolders. All existing script maps in the specified path and below were updated.
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For the SA XT Web Service add-on product, the Registration tool was run with the
following command:

C:\windows\Microsoft NET\Framework \v2.0.50727->aspnet_regiis —
sW3SVC/1/ROOT/SAXTWebService

This updated all existing script maps in the specified path and below.

Enabling Rational System Architect XT Web Service add-on

product

The Rational System Architect XT installation automatically installs and configures the
SA XT Web Service. The service is enabled with the purchase of a license (see pg. 36 for
licensing information).

Configuring the SA XT Web Service

If you need to verify or manually configure the SA XT Web Service, proceed as follows:

1.

Click Start> Settings> Control Panel> Administrative Tools, and click on Internet
Information Services. This launches the IIS console.

Expand the Local Computer node (which is usually indicated by your computer
name).

Right-click on the Default Web Site node and select New> Virtual Directory...
Click Next on the Virtual Directory Creation Wizard.

On the Virtual Directory Alias screen enter SAXTWebService in the Alias text
field and press Next.

On the Web Site Content Directory dialog enter the folder where SA XT Web
Service is installed (usually C:\Program Files\IBM\Rational\System
Architect Suite\SAXTWebService), or click Browse to select it, and click Next.

In the Access Permissions dialog, select Read and Run scripts, and click Next.

Click Finish on the final dialog of the Virtual Directory Creation Wizard.
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Verifying the SA XT Web Service properties

If you purchased the SA XT Web Service, and want to verify it is properly configured, or
wish to customize settings, perform the tasks in sections describe below. To verify and
configure most SA XT Web site properties, you need to launch the IIS serve as follows:

1.

Click on Start > Settings > Control Panel > Administrative Tools > and select
Internet Information Services.

Expand the local computer node. This is usually indicated by your computer name,
for example ComputerName (local computer).

Expand Web Sites and Default Web Site nodes.
Right click on the new SA XTWebService Web site and select Properties.

Checking and configuring ASP.NET mapping

On the Virtual Directory tab, click the Configuration... button.
On the Mappings tab, locate the .asmx entry in the Extension column.

The Executable Path column for this entry should display
C:\Windows\Microsoft .NET\Framework\v2.0.50727\aspnet isapi.dll.

If the .asmx entry appears and it contains values above for the Executable Path,
click OK and go to the “Set directory security” section below.

If it does not contain the values above, then SA XT Web Service was not mapped to
the correct version of ASP.NET. In this case, click Cancel to return to the Virtual
Directory tab. You need to map the SA XT Web Service as described in the
“Registering the NET Framework™ section on page 59.

Setting directory security

Click on the Directory Security tab.
Click Edit in the Anonymous access and authentication control group.

Check the Integrated Windows authentication checkbox, uncheck all other
checkboxes, and click OK.

Click OK in the SA XT Web Service Properties dialog to return to the I1IS Admin
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tool.

5. Click File and select Exit.

Editing the SA XT Web Service web.config file

Rational System Architect XT creates an Impersonation Account for the SA XT Web
Service from the User Name and Password that you enter during the installation. You
can change that User Name and Password in the web.config file (see “Editing the
web.config file” on page 47).

Other customizations you can apply to the web.config file of SA XT Web Service
include the following:

AppLogging - if set to "true" will cause SA XT Web Service to messages to the
application event log.
<add key="AppLogging" value="false"/>

SessionTimeOut controls the idle time in minutes before the session is destroyed. This
value is only used if the CheckSessionTimer is greater than 0.
<add key="SessionTimeOut" value="20"/>

CheckSessionTimer is the sleep time in minutes between the session idle checks. A
value of "0" will prevent the timer from starting, leaving the session to run until the
EndSession method is called.

<add key="CheckSessionTimer" value="20"/>

You can also add the <connectionStrings> key to enable access to Oracle encyclopedias
using Oracle authentication (See pg. 48).

Checking folder permissions for the SA XT Web Service Domain Account

If the Domain Account established for SA XT Web Service is different than the account
used for SA XT will need the same permissions on the folders described in the “Folders
and file(s) that require the Full Control permission” (pg. 50).

The SA XT Web Service web.config file contains an appSetting that allows the
administrator to control the folder used by the SA XT Web Service for temporary files.
The following example will force the SA XT Web Service to use the
C:\SAXTWebService folder:

<appSettingss>
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<add key="TempFolder" value="C:\SAXTWebService">
</appSettings>

By default, the web.config file does not contain a TempFolder value. Therefore, unless
you change it, SA XT Web Service uses the folder set by the operating system.

Testing the SA XT Web Service feature

The Rational System Architect XT Web Service provides a test page,
SAXTWebService.asmx, which confirms your service has been configured propetrly. The
page also lists the operations made available through the Web Service. Each operation
listed in the test page links to a page where you can test the operation and view sample
code. Since SA XT Web Setvice uses complex data types, you cannot test the methods
from this page. After installing and configuring SA XT Web Service modules, test it as
follows:

1. Click Start > Run, type cmd in the Open field, and click OK.

2. Type iisreset, and press Enter. This stops and restarts the services, then returns a
confirmation message that Internet Services Successfully Restarted.

3. Close the DOS window.

4. Launch Internet Explorer and enter the following URL:

http://<machinename>/SAXTWebService/SAXTWebService.asmx

Accessing Help for Rational System Architect XT and the Web Service

The Rational System Architect XT Web Service feature does not provide a user
interface, and therefore does not provide a help system. However, you can find a
summary of the Web Service modules in Rational System Architect XT’s help system.
You can access this directly from SA XT. You can also access the Help manually by
clicking on the default.htm file in the SA XT installation folder (usually C:\Program
Files\IBM\Rational\System Architect Suite\SAXT\Help)

Uninstalling Rational System Architect XT

Because of a known issue between the interaction of the licensing software and the
ASP.NET setvice in Microsoft Internet Information Services (IIS), a problem can occur
when you uninstall Rational System Architect XT. To prevent this problem from
occurring, follow the procedure below when you uninstall the application:
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Inform users logged onto any applications being hosted on the same IIS server as
Rational System Architect XT that the server will be taken down when you uninstall
the application.

From the 1IS console, stop the IIS service.

Uninstall Rational System Architect XT. Navigate to the Add or Remove Programs
utility from the Control Windows Panel. When the process completes, you should
also delete the following folders:

C:\Program Files\IBM\Rational\System Architect Suite
C:\Windows\Microsoft .NET\Framework\v2.0.50727\Temporary
ASP.NET\SAXT

C:\Windows\Microsoft .NET\Framework\v2.0.50727\Temporary
ASP.NET\SAXTWebService

(if you receive a ‘file in use’ message when attempting to delete
these directories, run the IISReset utility and try deleting them
again.)

From the IIS console, restart the IIS service.
Note: while restarting the service, an error may occur. You can ignore that error

because other applications are not affected, and the ASP.NET service will be
restarted once the 1IS service is started.
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Introduction

Rational System Architect version 11 or higher provides access control for shared,
enterprise-level encyclopedias administered and enforced by IBM Rational Rational
System Architect Catalog Manager. ™

This chapter provides you with instructions on how to create a catalog, and to
implement access control. The chapter is partitioned into sections that cover different
scenatios of installing the product.

Overview of Access Control with SA Catalog Manager

1 - Acquire a server dedicated to Rational System Architect Encyclopedias
2 - Install Rational System Architect and SA Catalog Manager

3 - Set up User rights to Encyclopedias

4 - Grant ‘SA Permissions’ to Users within an Encyclopedia
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Overview of Access Control with SA Catalog Manager

Rational System Architect Catalog Manager is utility that provides role-based, enterprise-
level access control to Rational System Architect encyclopedias. Access control is
enforced by a catalog. You attach to the catalog encyclopedias to which you want to
control access. In SA Catalog Manager, you create Users, assign encyclopedias to them,
and then assign Users one or more Roles that they can perform on catalogued
encyclopedias. SA Catalog Manager also lets you to control the Rational System
Architect menus that are enabled, and the macros that can be executed by a role.

SA Catalog Manager is automatically installed when you install Rational System Architect
and Rational System Architect XT. If you do not want to install SA Catalog Manager on
your computer, you can perform a custom SA or SA XT install and remove SA Catalog
Manager from products to install. In order to run SA Catalog Manager you need to have
it listed in your license.dat file.

Enterprise Catalogs

An enterprise catalog is an SQL Server database that holds information about other
databases (i.e., Rational System Architect encyclopedias) on the same server, and that by
having encyclopedias attached to it, can control who can access those encyclopedias, and
what they can do in them. In Oracle, the catalog is a schema within the database.

There is a one-to-one correspondence between a server and a catalog, and one catalog
can control access to multiple encyclopedias. SA Catalog Manager also controls
permissions to the catalog database, enabling you to assign the Administrator role to
other users. This lets you relegate some or all catalog-related tasks to others. However, as
the SA Catalog Manager installer, you have ultimate control over catalogs and by
extension, to all the encyclopedias you attached to them.
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Overall Steps for implementing Access Control via SA Catalog Manager

The installation wizards for both Rational System Architect and Rational System
Architect XT install SA Catalog Manager. It does not matter from where you run SA
CM, as long as you do posses the required permissions. The basic steps for installing SA
Catalog Manager and then implementing access control via SA Catalog Manager are as

follows:

1.

Acquire a SQL Server installation or an Oracle database installation dedicated to
SA encyclopedias (databases).

Install Rational System Architect or Rational System Architect XT, both of
which install SA Catalog Manager by default:

a. If using a Citrix or Terminal Server installation, install SA and SA Catalog
Manager to the Terminal Server or CITRIX machine. In this scenario, it is
recommended, though not required, that you have a fast connection (e.g. 1 Gb)
to the SQL Server or Oracle server. Check the SA XT Readme file for
minimum requirements.

OR

b. Install SA to each person's machine and desighate one machine (the Rational
System Architect administratot's machine) as the one licensed to run SA and SA
Catalog Manager.

These installation scenarios are both represented by machine C in the figure
shown in the "SA XT installation overview" section in chapter 1 of this guide.
Set up user rights to the server and its encyclopedias.

Use SA Catalog Manager to create a catalog and grant permissions for access
within each encyclopedia based on roles. These can be thought of as ‘Rational
System Architect (SA)’ permissions.
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1 - Acquire a server dedicated to Rational System Architect
Encyclopedias

The first step in the process is to acquire a server that will be used to house Rational
System Architect encyclopedias.

Server Requirements

Rational System Architect supports the following versions of these servers/databases for
use as the underlying repository that you build encyclopedias on:

e SQL Setver 2000 (SP3 or SP4) or SQL Setver 2005.
e Oracle 91 (9.2.0.6) or 10g

Important server recommendation

It is highly recommended that the SQL Server or Oracle database setver that you acquire
will be used exclusively for Rational System Architect encyclopedias. It is not advised to
share a SQL Server or Oracle installation with other software applications. There are a
number of reasons for this — first, SA users will need rights to create and modify
databases on the server, rights that may not normally be granted to the typical database
user. Second, if the server is being used for other database activity, SA performance will
be affected.
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2 - Install Rational System Architect and SA Catalog Manager

A. Install Rational System Architect

The complete installation instructions for Rational System Architect are provided in the
Rational System Architect Installation Guide. In general, Rational System Architect is
typically installed using one of the following strategies:

e Rational System Architect can be installed to a Citrix or Terminal Server
environment. If so, then Rational System Architect should be installed to a separate
machine from the one that is housing SQL Setver or Oracle, but with a fast (1GB)
connection between it and that server machine.

e Rational System Architect can be installed to each uset’s machine and used to access
encyclopedias on the server via a fast network. If so, the network must be of
sufficient bandwidth to enable many concurrent users (at least 100 Mb connections
with a throughput of 40-60 Mbps for upstream and downstream throughput). Please
see the Readme.htm file for more information on network throughput requirements
and recommendations.

B. Install SA Catalog Manager as part of Rational System Architect Install

By default, SA Catalog Manager is installed by the Rational System Architect (and
Rational System Architect XT) installation. You may optionally turn off the SA Catalog
Manager installation if you choose Custom Install while running the Rational System
Architect installation wizard.

However, only users with a valid license to use SA Catalog Manager can run the
program. The SA Catalog Manager license is an option in the license.dat file. Typically,
an organization should have the designated Rational System Architect administrator
granted a license to run SA Catalog Manager, so that only the administrator can grant
access control for other users on encyclopedias.

Where to install SA Catalog Manager

If running Rational System Architect in a Terminal Server or Citrix environment, then
you typically install SA Catalog Manager to the Terminal Server machine along with
Rational System Architect (which again, happens by default). The Rational System
Architect administrator then uses SA Catalog Manager on the Terminal Server machine
to control access to encyclopedias on the SQL Server or Oracle machine.
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If running Rational System Architect in a network configuration where Rational System
Architect is installed on each user’s machine, then SA Catalog Manager is installed on
the designated Rational System Architect administrator’s machine, which is typically the
one licensed and used to control access to encyclopedias housed on the SQL Server or
Oracle machine on the network.

Installing SA Catalog Manager

1. Insert the Rational System Architect DVD (or double click on the Rational System
Architect executable downloaded from the IBM IBM Rational support site). The
auto-run interface is launched.

2. Use the Installation Wizard to guide you through the entire Rational System
Architect installation.

3. When you encounter a dialog that asks if you would like a Complete or Custom
Installation, either leave the Complete Installation check box selected, or make sure
SA Catalog Manager is selected in the sub-dialog if you choose Custom Installation.

The SA Catalog Manager installation does not create a catalog. It cannot assume you
want to create one, or determine whete to create one. On the first run after installation,
SA Catalog Manager prompts you whether to search for servers, and then prompts you
whether you would like to create a catalog on one of the servers that is found.
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3 - Set up User rights to Encyclopedias

Users of Rational System Architect Enterprise encyclopedias have their permissions
managed by the role they are assigned in SA Catalog Manager. Two main types of Roles
can be assigned. One is the Administrator role, and the other a standard role, such as
Business Modeler, Data Modeler, and so on. The main difference between these types of
roles is that the Administrator role can perform tasks on the catalog (add a user, for
example), while the other roles can only perform tasks on encyclopedias. These role
types can be classified as the 'SA Admin' and the 'SA Uset' role; each of them is desctibe
in more detail in the sections that follow.

A. Set up User Rights to Encyclopedias for SQL Server

The process flow diagram below highlights the steps you need to perform to set up user
rights to encyclopedias for SQL Server. The next few sections provide written detail for
these steps.
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1. Grant Server Rights to create Encyclopedias (DBCreator)

On the Setver, the System Administrator must provide ‘DBCreator’ rights to the Group
of users that will create encyclopedias (an encyclopedia is a database on SQL Server).
This is performed using Microsoft SQL Server 2000 Enterprise Manager or SAEM
(Rational System Architect Encyclopedia Manager). Typically, the System Administrator
creates a Group that includes all SA users who will be granted ability to create
encyclopedias. The right to create encyclopedias (databases) on the server is not
necessarily given to everyone who will be using Rational System Architect — if you did,
you might get a proliferation of encyclopedias created. A recommended approach is for
administrators to call this Group the ‘SA Admin’ group. For SQL Server and SQL
Server Express, this Group needs to be given the Server Role of System Administrator
or DBCreator to create databases (encyclopedias) on the servet.

2. Create a Catalog on a SQL Server

Itis a good idea to know the server name before creating a catalog. If you don't have the
name, then SA Catalog Manager can search the network for you, but this can take a long
time to complete, with the possibility that servers behind firewalls may not be found.
Knowing the server name makes this procedure complete much faster because you can
enter the server name manually and avoid having SA Catalog Manager search the
network.

1. The first time you run SA Catalog Manager it informs you that no catalogs are
registered to you on your computer, and it asks whether you would like to search for
catalogs.

Click Yes, if you do not know which servers are available. This will cause SA
Catalog Manager to search all servers that your computer is connected to. Some
servers may not be found if they are hidden or protected by a firewall. For servers
such as these, you may need to enter their path and names manually.

OR

Click No, which will let you create the catalog on a server that you specify. You
should know the server path and name on which you will create the catalog.

2. Enter the path and name of the server on which to create the catalog or select one
from the list. Regardless of your choice to the above step, a second dialog is
presented, where you specify the server on which to create a Catalog. The dialog
contains a combination text and drop-down field, in which you can type in the
server name and path, or click the drop-down arrow to select a server from a list
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(this method searches for setvers that you’re connected to and can take a long time
in large scale environments).

3. Click OK..

3. Grant Database Rights

For each encyclopedia (SQL Server database), your System Administrator must provide
rights to the Group (or each individual) that will use the encyclopedia — in other words
open it, and create or modify diagrams and definitions within it.

Rights for ‘SA User’ Group

For users to be able to use an encyclopedia, the Administrator must grant them the
following Database Access on each encyclopedia (database) within which they will be
working:

e db_datareader and
e db_datawriter.

These rights are granted using SQL Server 2000 Enterprise Manager or SQL Server
Express. Typically, the System Administrator creates a Group that includes all SA users
who will be granted ability to work in encyclopedias, and then grants db_datareader and
db_datawriter database access for this Group on each encyclopedia.

Rights to SA Catalog Manager’s TelelogicEnterpriseCatalog Database

When you create a catalog with SA Catalog Manager, you actually create a special
database that carries a triplet of information (access permissions per role per
encyclopedia) that allows users to access information in encyclopedias based on their
role. This database is called the TelelogicEnterpriseCatalog database. All users must be
granted the following rights to this TelelogicEnterpriseCatalog database to work in
Enterprise encyclopedias (those put under access control):

e db_datareader

Only Administrators of the catalog need the db_datawriter permission.
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The user Group (or all users) must also be given db_datareader, db_datawriter, and
EXECUTE permissions for the following stored procedures for the encyclopedia
database to be allowed full access to the encyclopedia:

CREATESNAPSHOT GETHISTORYLOGGINGSTATUS
ENTITYEXISTSBYID LOGENTITYHISTORYUPDATE
LOCKENTITYBYID LOGFILESHISTORYUPDATE
GETNEXTID PURGEHISTORY

GETFILESIZE SAVEAUDITSETTINGS
DELETEBYID SAVECHANGECONFIG

Additionally, a user needs Select, Insert, Update, and Delete rights on the following
tables of the TelelogicEnterpriseCatalog:

CATALOGPERMISSION ROLE
ENCYCLOPEDIA ROLESUMS
ENCYPERMISSION USERENCYROLE
ILAC_DEFAULTCATALOGGROUPS = USERGROUPS
ILAC_DEFAULTENCYGROUPS VERSION
OPTIONS XTUSERENCYXML
PERMISSION USER

Note: To view and access encyclopedias that are attached to a catalog on SQL Server
2005, you need the VIEW SERVER STATE permission, in addition to the above. This
enables the sp_lock function, needed to ensure only one person at a time can open and
update the catalog. An administrator can grant VIEW SERVER STATE permission in
the master database by executing the following query:

GRANT VIEW SERVER STATE TO <login>, where <login> is an actual value.

Please note, for SQL Server 2000: If you have not installed SQL Server 2000 SP4, you
also need Execute on the extended stored procedure XP_UserLock. For more
information on XP_UserLock, please see Microsoft’s support Web Site:

http://support.microsoft.com/default.aspx?scid=kb%3Ben-us%3B819829.

This is granted to the user by the System Administrator through SQL Server Enterprise
Manager (versions 2000 or 2005).
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Rights for ‘SA Admin’ Group - Users who can create Encyclopedias
All users who can create encyclopedias on the setver or have created encyclopedias in
the past must be given the following rights on the TelelogicEnterpriseCatalog database
(the ‘catalog’):

e db_ddladmin,
e db_datareader and
e db_datawriter.

The db_ddladmin right enables usets to convert an encyclopedia from one version of
Rational System Architect to the next automatically. Between versions, the stored
procedures for Rational System Architect may change to improve petformance. Because
of this, it becomes necessary for the owner of an encyclopedia (the one who created it)
to be the first one to open it with the new version, and that person needs db_ddladmin
rights to the encyclopedia and to the TelelogicEnterpriseCatalog database.
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The user Group (or all users) must also be given db_ddladmin, db_datareader,
db_datawriter, and EXECUTE permissions for the following stored procedures for the
encyclopedia database to be allowed full access to the encyclopedia:

CREATESNAPSHOT GETHISTORYLOGGINGSTATUS
ENTITYEXISTSBYID LOGENTITYHISTORYUPDATE
LOCKENTITYBYID LOGFILESHISTORYUPDATE
GETNEXTID PURGEHISTORY

GETFILESIZE SAVEAUDITSETTINGS
DELETEBYID SAVECHANGECONFIG

Additionally, a user needs Select, Insert, Update, and Delete rights on the following
tables of the TelelogicEnterpriseCatalog:

CATALOGPERMISSION ROLE
ENCYCLOPEDIA ROLESUMS
ENCYPERMISSION USERENCYROLE
ILAC_DEFAULTCATALOGGROUPS USERGROUPS
ILAC_DEFAULTENCYGROUPS VERSION
OPTIONS XTUSERENCYXML
PERMISSION USER

Note: To view and access encyclopedias that are attached to a catalog on SQL Server
2005, you need the VIEW SERVER STATE permission, in addition to the above. This
enables the sp_lock function, needed to ensure only one person at a time can open and
update the catalog. An administrator can grant VIEW SERVER STATE permission in
the master database by executing the following query:

GRANT VIEW SERVER STATE TO <login>, where <login> is an actual value.

Please note, for SQL Server 2000: If you have not installed SQL Server 2000 SP4, you
also need Execute on the extended stored procedure XP_UserLock. For more
information on XP_UserLock, please see Microsoft’s support Web Site:

http://support.microsoft.com/default.aspx?scid=kb%3Ben-us%3B819829.

This is granted to the user by the System Administrator through SQL Server Enterprise
Manager (versions 2000 or 2005).
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B. Set up User Rights to Encyclopedias for Oracle

In Oracle, like encyclopedias, the catalog is schema, which is named the
TelelogicEnterpriseCatalog. The overall steps for setting up access to the
TelelogicEnterpriseCatalog in Oracle are as follows:

1. Grant Access Rights for Oracle

For users to edit an encyclopedia in an Oracle server, they must have Select, Insert,
Update and Delete rights on the following tables, which Rational System Architect
creates automatically:

ENTITY RELATIONSHIP
ERROR_LOG CRITICALREGION
FILES SINGLETHREAD
IDGENERATOR FILES_HISTORY
SAPROPERTIES ENTITY_HISTORY

ENTITY_FLAGS

Additionally, to edit an encyclopedia in Oracle, a user also needs the Execute on the
following stored procedures:

CREATESNAPSHOT GETHISTORYLOGGINGSTATUS
ENTITYEXISTSBYID LOGENTITYHISTORYUPDATE
LOCKENTITYBYID LOGFILESHISTORYUPDATE
GETNEXTID PURGEHISTORY

GETFILESIZE SAVEAUDITSETTINGS
DELETEBYID SAVECHANGECONFIG

Additionally, a user needs Select, Insert, Update, and Delete rights on the following
tables of the TelelogicEnterpriseCatalog:

CATALOGPERMISSION ROLE
ENCYCLOPEDIA ROLESUMS
ENCYPERMISSION USERENCYROLE
ILAC_DEFAULTCATALOGGROUPS USERGROUPS
ILAC_DEFAULTENCYGROUPS VERSION
OPTIONS XTUSERENCYXML
PERMISSION USER
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2. Create a Catalog on the Oracle Server

1. The first time you run SA Catalog Manager it informs you that no catalogs are
registered to you on your computer, and it asks whether you would like to search for
catalogs. Click No, because SA Catalog Manager cannot search for catalogs on
Oracle servers.

2. In the dialog presented, enter the name of the Oracle server on which you want to
create the catalog.

3. Click OK.

4 - Grant ‘SA Permissions’ to Users within an Encyclopedia

This section details how to set up access control for users based on their role on a pet-
encyclopedia basis. The section assumes that you have already created a catalog, per
instructions provided in section 11.3 of this chapter.

You create and use one and only one catalog per server, whether it is a SQL Server, SQL
Server Express, or Oracle server. One catalog controls access to multiple encyclopedias
on the same server. A catalog on one server cannot control access to encyclopedias on a
different server.

Overall steps to create a Catalog and implement Access Control

Once again, to follow the steps of this section, you must first create a catalog on the
server where the encyclopedias to be brought under access control reside. The steps to
create a catalog are specified in section 11.3 of this chapter.

Afterwards, and in no particular order, you need to attach encyclopedias to the catalogs,
create Users, assign Users to encyclopedias, and assign Users one or more Roles, per
encyclopedia.

The overall steps to create a catalog and implement access control are as follows:
Create a Catalog on an SQL Server, SQL Server Express, or Oracle Server.

1. Attach Encyclopedias to a Catalog.

2. Add Users to the Catalog.

3. Assign Users to Encyclopedias.

4

Assign Roles to Users.
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A. Attach Encyclopedias to an Enterprise Catalog

Attaching an encyclopedia to a catalog makes it ready for you to assign it to Users. There
are two methods to attach an encyclopedia. From SA Catalog Manager, you can use the
Attach Encyclopedia command. From Rational System Architect, when you create a new
encyclopedia, you can select Enterprise Encyclopedia as the type, and choose the option
to make the encyclopedia available to other users. Each of these methods is described
below.

To attach an encyclopedia in SA Catalog Manager proceed as follows:
1. Right click on the Encyclopedias node and select Attach.

2. C(lick the Select an encyclopedia to attach
drop-down and select an encyclopedia.

3. Click OK.

To create and attach an Enterprise encyclopedia in Rational System Architect:

4. Click File and select Open Encyclopedia.

5. Click the New icon.

6. Select the checkbox for Enterprise encyclopedia.

7. Continue creating the new encyclopedia by entering your data in these fields:
Connection (specifies the server name, server type and security)
New Encyclopedia name

8. Check the Allow others to access this encyclopedia checkbox. This makes your
newly created Enterprise encyclopedia appear under the Encyclopedias node in SA
Catalog Manager.
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B. Create new Users

All new Users or User Groups are given the Read permission to the catalog. This
enables them to see encyclopedias of the type Enterprise Encyclopedia in Rational
System Architect's Open Encyclopedia dialog. Once you cteate a User or a User Group,
you must assign those Roles to perform on encyclopedias, per encyclopedia.

To create a New User:
1. Right-click on the root node Users & Groups and select New User.

2. In the Name field, enter a user name in the format DomainName\UserName,
where DomainName is the name of your network domain, and the UserName is the
name you use to log into your Windows operating system.

3. Enter a value no greater than seven characters in the Audit ID field. If you exceed
this limitation, the value you enter is clipped after the seventh character. Rational
System Architect uses the Audit ID to track user activity throughout an
encyclopedia.

4. Click OK

C. Assign Users to Encyclopedias

A User that is assigned to an encyclopedia must also be assigned a Role to play on that
encyclopedia. If you assign a User to an encyclopedia and shut down SA Catalog
Manager before assigning that User a Role on the encyclopedia, the assignment of the
User to the encyclopedia is dropped.

The sections that follow described two procedures you need to complete for a User to
work on an encyclopedia.

To assign a User to an Encyclopedia:
1. Expand the root Users & User Groups node (click the '+").
2. Right-click on a User and select Copy.

3. Expand the root Encyclopedias node, and beneath it, expand the encyclopedia to
which you are assigning the User.

4. Right-click on the encyclopedia you selected in the above step, and select Paste.

5. A node is created for the User that you pasted, and its name is displayed in a blue,
italicized font, which denotes the assignment temporary. The User must also be
assigned a Role for the assignment to become permanent, as described below.
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D. Assign Roles to Users

1.
2.
3.

Expand the root Roles node.
Right-click on a Role, and select Copy.

Right-click on the Users & User Groups node (which should still be expanded and
displayed in a blue, italicized font) and select Paste.

Note:The blue and italicized font convert to black and normal (i.e., not italicized),
denoting that the User has been successfully assigned a Role on the encyclopedia of
which he or she is a User.

E. Open Catalogued Encyclopedia in Rational System Architect

The Encyclopedia you attached to the catalog is now subject to access control as
administered by SA Catalog Manager. For anyone to open a catalogued encyclopedia in
Rational System Architect, they must exist as a User in a catalog, be assigned to the
encyclopedia, and be assigned one or more roles on their assigned encyclopedias.

Rational System Architect can open both catalogued and non-catalogued encyclopedias.
Catalogued encyclopedias ate termed Enterprise Encyclopedia, and non-catalogued
are termed Professional. In Rational System Architect’s Open encyclopedia dialog, you
can select which type to open by clicking on the Existing icon, select the Connection
name and a list will be provided with the different encyclopedias that are attached to that

server.

1. Start Rational System Architect.

2. Click Open Encyclopedia icon, or select it from the File menu.
For existing encyclopedias, click the Existing icon and select the Connection.
For new encyclopedias, click the New icon, then specify a Connection. (see the To
create and attach an Enterprise encyclopedia in Rational System Architect section
above).

3. Click OK.

4. The diagrams, definitions that the user can view, and the menu commands that he

ot she can execute are all determined by the catalog, as configured by the Network
or Rational System Architect Administrator with SA Catalog Manager.
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Installing Rational SA and SA XT on same 4
machine

Introduction

You can install Rational System Architect and System Architect XT on the same
machine. This feature is especially useful for consultants and Systems administrators
who want to be able to use all the features of Rational System Architect, and to be able
to use the distinct features of the Rational System Architect XT product. Previously, you
could not install both products on the same machine.

Overview

When you install Rational System Architect, all available features are installed. This
includes Cobol Import, INI File Editor, SA Catalog Manager, SA Compare, SA
Publisher SAEM (Oracle) and SAEM (SQL Server). It also includes all the help files for
those features. Combined, all these features make up the Rational System Architect suite
of tools.

When you install Rational System Architect XT, only a subset of the available features is
installed, including Rational System Architect SA Catalog Manager, SAEM (Oracle) and
SAEM (SQL Server). Additionally, some features exclusive to Rational System Architect
XT are installed, including Microsoft I1IS server components, and a distinct browser-
based help system.
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Installation Requirements

There are some requirements and restrictions to consider when you install both products
on the same machine. Among the requirements are the following:

e You have to install Rational System Architect first, and install Rational System
Architect XT second. When you install Rational System Architect XT, it will use the
same Rational System Architect installation directory, without prompting you to
choose an alternate directory.

e The versions of Rational System Architect and Rational System Architect XT have
to be the same. If you attempt to install Rational System Architect XT over a
different version than Rational System Architect, the installation cannot be
completed.

Among the restrictions are the following:

e You cannot run Rational System Architect while you are running Rational System
Architect XT as a server.

Installing Rational System Architect XT over Rational System Architect

When you start the Rational System Architect XT installation, it detects whether Rational
System Architect is already installed. If it is installed, and it is the same version as the
Rational System Architect XT version you are attempting to install, the install is allowed
to proceed. If the installed Rational System Architect version is not the same as the
Rational System Architect XT version you want to install, the installation terminates.

To install Rational System Architect XT over Rational System Architect proceed as
follows:

1. Run the Rational System Architect XT installation file. The installation process is the
same as if Rational System Architect were not installed, except for the important
distinction that you cannot select a path. Rational System Architect XT must use the
same path because it will install over Rational System Architect incrementally,
adding only those components that ate not already installed.

2. Complete the installation as instructed by the installation wizard to complete.
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Running Rational System Architect when Rational System Architect XT is also

installed

Because both applications use the same executable, sa2001.exe, launching that executable
from shortcuts or directly from the application folder works differently. When only
Rational System Architect is installed, the executable always runs in ‘noisy” mode,
meaning the product is launched with the user interface. However, when you also install
Rational System Architect XT on the same machine, clicking on the executable file in the
application folder launches Rational System Architect XT in ‘quiet’ mode, without the
user interface.

To run Rational System Architect with the user interface, use the shortcuts in the
Y
Windows Start menu, or in the Desktop (if you chose to have one created there when
p uty
you installed Rational System Architect.). Those shortcuts contain a parameter in “Target’
property to run the application in ‘noisy’ mode, as follows:

C:\Program Files\IBM\Rational\System Architect
Suite\1l1l.3\System Architect\sa2001.exe -enableui

There are no shortcuts provided to run Rational System Architect XT in ‘noisy’ mode.
However, when only Rational System Architect XT is installed, you can create a shortcut
to run it in ‘noisy’ node by creating a shortcut for it with the parameter above. Normally,
Rational System Architect XT runs in ‘silent’ mode

If you choose to uninstall Rational System Architect XT, these shortcuts remain
unaffected and Rational System Architect will continue to run with the user interface.

Uninstalling Rational System Architect XT

The installation process for either product works the same as if only one of them were
installed. In other words, each product is listed in the Add or Remove Programs dialog
of the Windows Control Panel. However, you should consider the following factors
when you uninstall Rational System Architect or Rational System Architect XT when
both are installed in the same computer:

e If you attempt to uninstall only Rational System Architect, Rational System Architect
XT will cease to work properly because common files are deleted. In this scenario,
you can continue to uninstall Rational System Architect, but you are advised that
you should also Rational System Architect XT.

e When you uninstall Rational System Architect XT, no special information is
provided. Even though common files ate also deleted in this instance, Rational
System Architect will reinstall those files the next time it is started. This is the

Rational System Architect and System Architect XT Installation Guide 87



Installing Rational SA and SA XT on same machine

standard behavior whenever Rational System Architect files are deleted.
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Contacting IBM Rational Software Support

Prerequisites

If you cannot resolve a problem with the self-help resources, contact IBM® Rational®
Software Support.

Note: If you ate a heritage Telelogic customer, you can find a single reference site for all
support resources at http://www.ibm.com/software/rational/support/telelogic

To submit a problem to IBM Rational Software Support, you must have an active
Passport Advantage® software maintenance agreement. Passport Advantage is the IBM
comprehensive software licensing and software maintenance (product upgrades and
technical support) offering. You can enroll online in Passport Advantage at
http://www.ibm.com/software/lotus/passportadvantage /howtoenroll.html
e To learn more about Passport Advantage, visit the Passport Advantage FAQs at
http://www.ibm.com/software/lotus/passportadvantage/brochures faqs quickguides.

html.
e  For further assistance, contact your IBM representative.
To submit a problem online (from the IBM Web site) to IBM Rational Software
Support:
e Register as a user on the IBM Rational Software Support Web site. For details
about registering, go to http://www.ibm.com/softwate/support/.

e Be listed as an authorized caller in the service request tool.
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Other information

For Rational software product news, events, and other information, visit the IBM
Rational Software Web site: http:

Submitting Problems

www.ibm.com/software/rational/.

To submit a problem to IBM Rational Software Support:

1. Determine the business impact of the problem. When you report a problem to
IBM, you ate asked to supply a severity level. Therefore, you need to understand

and assess the business impact of the problem.

To determine the severity level, use the following table.

Severity

Description

1

The problem has a critical business impact:
you are unable to use the program, resulting
in a critical impact on operations. This
condition requires an immediate solution.

The problem has a significant business
impact: the program is usable, but it is
severely limited.

The problem has some business impact: the
program is usable, but less significant
features (not critical to operations) are
unavailable.

The problem has minimal business impact:
the problem causes little impact on
operations or a reasonable circumvention to
the problem was implemented.

2. Describe the problem and gather background information. When you describe
the problem to IBM, be as specific as possible. Include all relevant background
information so that IBM Rational Software Support specialists can help you
solve the problem efficiently. To save time, know the answers to these

questions:
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applicable to you:

o Start the IBM Installation Manager and click File > View
Installed Packages. Expand a package group and select a
package to see the package name and version number.

o Start your product, and click Help > About to see the
offering name and version number.

e What is your operating system and version number (including any
service packs or patches)?

¢ Do you have logs, traces, and messages that are related to the problem
symptoms?

e (Can you recreate the problem? If so, what steps do you perform to
recreate the problem?

e Did you make any changes to the system? For example, did you make
changes to the hardware, operating system, networking software, or
other system components?

Are you currently using a workaround for the problem? If so, be prepared to
describe the workaround when you report the problem.

Submit the problem to IBM Rational Software Support in one of the following
ways:

e Online: Go to the IBM Rational Software Support Web site at
https://www.ibm.com/software/rational/support/. In the Rational support
task navigator, click Open Service Request. Select the electronic
problem reporting tool, and open a Problem Management Record
(PMR) to describe the problem.

e For more information about opening a service request, go to
http://www.ibm.com/software/support/help.html.

®  You can also open an online service request by using the IBM Support
Assistant. For more information, go to
http://www.ibm.com/software/support/isa/faq.html.

e By phone: For the phone number to call in your country or region, visit
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the IBM directory of worldwide contacts at
http://www.ibm.com/planetwide/ and click the name of your country or
geographic region.

e Through your IBM Representative: If you cannot access IBM Rational
Software Support online or by phone, contact your IBM
Representative. If necessary, your IBM Representative can open a
service request for you. For complete contact information for each
country, visit http://www.ibm.com/planetwide/.
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Appendix

Notices

© Copyright IBM Cotporation 1986, 2009.

This information was developed for products and services offered in the U.S.A. IBM
may not offer the products, services, or features discussed in this document in other
countries. Consult your local IBM representative for information on the products and
services currently available in your area. Any reference to an IBM product, program, or
service is not intended to state or imply that only that IBM product, program, or service
may be used. Any functionally equivalent product, program, or setvice that does not
infringe any IBM intellectual property right may be used instead. However, it is the uset's
responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described
in this document. The furnishing of this document does not grant you any license to
these patents. You can send written license inquiries to:

IBM Director of Licensing
IBM Corporation

Nortth Castle Drive
Armonk, NY 10504-1785

For license inquiries regarding double-byte character set (DBCS) information, contact
the IBM Intellectual Property Department in your country or send written inquiries to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS 1S” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions. Therefore, this statement may not apply to
you.
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This information could include technical inaccuracies or typographical errors. Changes
are periodically made to the information herein; these changes will be incorporated in
new editions of the publication. IBM may make improvements and/or changes in the
product(s) and/or the program(s) desctibed in this publication at any time without
notice.

Any references in this information to non-IBM Web sites are provided for convenience
only and do not in any manner serve as an endorsement of those Web sites. The
materials at those Web sites are not part of the materials for this IBM product and use of
those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs and
other programs (including this one) and (ii) the mutual use of the information which has
been exchanged, should contact:

Intellectual Property Dept. for Rational Software
IBM Corporation

1 Rogers Street

Cambridge, MA 02142

US.A

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it
are provided by IBM under terms of the IBM Customer Agreement, IBM International
Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment.
Therefore, the results obtained in other operating environments may vary significantly.
Some measurements may have been made on development-level systems and there is no
guarantee that these measurements will be the same on generally available systems.
Furthermore, some measurements may have been estimated through extrapolation.
Actual results may vary. Users of this document should verify the applicable data for
their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those
products, their published announcements or other publicly available sources. IBM has
not tested those products and cannot confirm the accuracy of performance,
compatibility or any other claims related to non-IBM products. Questions on the
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capabilities of non-IBM products should be addressed to the suppliers of those
products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the names
of individuals, companies, brands, and products. All of these names are fictitious and any
similarity to the names and addresses used by an actual business enterprise is entirely
coincidental.

Copyright license

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to IBM, for
the purposes of developing, using, marketing or distributing application programs
conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested
under all conditions. IBM, thetefore, cannot guarantee or imply reliability, serviceability,
or function of these programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (yout company name) (year). Portions of this code are detived from IBM Corp.
Sample Programs. © Copyright IBM Cotp. 2000 20009.

If you are viewing this information softcopy, the photographs and color illustrations may
not appear.
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Appendix

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be tradematks of IBM or other companies. A
current list of IBM trademarks is available on the Web at “Copyright and trademark
information” at www.ibm.com/legal/copytrade.html

Microsoft and Windows are trademarks of Microsoft Corporation in the United States,
other countries, or both.

Other company, product or service names mentioned may be trademarks or service
marks of others.
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